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Welcome to Umler 
Railinc’s Umler® is a web application that provides a variety of enhanced equipment management 
functions. This chapter presents an overview of Umler, its system requirements, descriptions, and 
references to supporting documentation, contacts, as well as a description of standard Railinc user 
interface elements and Umler-specific interface elements. 

Overview 
Umler is the industry’s central repository for registered rail and intermodal equipment in North 
America. This system rests at the heart of nearly all railway activities. It is critical for effective 
industry interline operations. It provides the physical characteristics of equipment and the 
inspection data needed for the safe routing, loading capabilities, and rating information for car 
hire accounting. Virtually all the electronic exchange of rail equipment data relies in one form or 
another on Umler. It serves as the industry’s database for equipment management and inspection 
information. 

Industry leaders commissioned the development of Railinc’s Umler to facilitate the industry’s 
ever-changing business rules and government regulations. 

Railinc’s Umler allows users to access and manage rail equipment information through an 
internet application. The Umler user interface promotes greater efficiency by providing web-
based access to the Umler database, allowing users to query and to make real-time updates to 
their data. This system has been designed to meet the data integrity needs of our customers by 
providing this greater flexibility in a fully secure environment. 

User Guide Structure 
This document has been organized to reflect the application menu order of Umler. It describes use 
and interpretation of the interface elements in Umler. 

Dictionary-like retrieval text appears in the headers. A full index is included. 

Screen captures generally show only the content area of the web pages (headers and footers have 
been removed). 

Railinc Single Sign-On (SSO) information has been removed, and references to the Single Sign-
On User Guide and Single Sign-On Administrator Guide were added where needed.  

Whenever possible the term “select” is used to indicate making a choice using either the mouse or 
keyboard. Left click with your mouse to activate a control or select an item.  

Links in this document may take you to another section of the user guide, open a document, 
website page, or email. 
 

General User Interface and System Requirements 
General user interface information (typical keyboard selection equivalents and shortcuts), as well 
as system requirements are available in the Railinc UI Dictionary. Application-specific interface 
information is described in the next section. 

https://public.railinc.com/sites/default/files/documents/SSOUserGuide.pdf
https://public.railinc.com/sites/default/files/documents/SSOUserGuide.pdf
https://public.railinc.com/sites/default/files/documents/SSOAdminUserGuide.pdf
https://public.railinc.com/sites/default/files/documents/Railinc_UI_Dictionary.pdf
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Requesting Changes to Umler 
Use the following procedure to request changes to Umler: 

1. Open the Umler Change Request. 

2. Complete the document and save it to your computer (leave open). 

3. Select the link at the top of the form. This opens an email to the Railinc Customer Success 
Center with the subject line “Umler Change Request.” 

4. Attach the saved document.  

5. Send the email.  

 

Supporting Documentation 
Umler Data Specifications Manual 

The Umler Data Specifications Manual provides the data requirements and input formats to 
register equipment into the Umler system and is needed when registering equipment. It also 
contains tables of business rules and field definitions. The current version of the Umler Data 
Specifications Manual and other reference materials can be downloaded from Umler product page 
on Railinc.com. Select the References menu item from any page to open the Umler product page. 

AAR Field Manual 
Published by the Association of American Railroads (AAR), this manual contains all rules 
dealing with the care and repair, responsibility for, disposition of, settlement of freight 
equipment. It includes the procedures for the operating and billing of maintenance pools. 

Information for ordering this manual can be found on the AAR’s publication website at 
https://aarpublications.com/. 

Railinc Customer Success Center 
The Railinc Customer Success Center (CSC) is a free service to Umler users and is operational 
twenty-four hours a day, every day of the year. Call (877) 724-5462 or email csc@railinc.com to 
report problems accessing Umler. Password, user ID and other issues related to access will be 
solved as soon as possible.  

User Interface 
The Umler interface provides the same navigational tools found in most Windows applications 
and internet sites. This section provides basic explanations of the elements and components that 
assist in moving through the various pages of the application to complete tasks.  

 

https://public.railinc.com/sites/default/files/documents/Umler%20Change%20Request.dotx
https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
https://public.railinc.com/products-services/umler-system
https://aarpublications.com/
mailto:csc@railinc.com
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Railinc Page Layout 
Each page in a Railinc web application has the same structure. 

Exhibit 1. Railinc Application Layout 

 

1 Logo—Railinc logo. The logo is a link to the Railinc Corp website. 

2 Application Title—Name of the application. This is also a link to the Home page of the 
application. 

3 User ID—Logged in user. 

4 Company—Company the user represents. This is for individuals representing more than one 
road. Selecting this link while logged in (RAIL is shown in the example below) opens the 
User Mark Selection pop-up. Enter or select the company on whose behalf you’ll be 
working—without logging out. 

Exhibit 2. User Mark Selection 
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5 Launch Pad— Clicking on this provides a drop-down menu of Launch Pad links in order to 
switch to other authorized Railinc applications (top) or go to User Services functions 
(bottom), e.g., change passwords, request other applications (Exhibit 3). 

Exhibit 3. Launch Pad Drop-Down Menu 

 

6 Sign Out—Logs out of current application and returns to the Railinc SSO login page. 

7 Application Menu—The top of the Railinc page displays the application menu options. The 
options on this menu allow you to perform the various functions of the application. Some 
specific options include: 

• References—Opens a page with links to various reference training materials (e.g., quick 
guides, specification manual, task videos, webinars, etc.). 

8 Page Title—The title of the specific application task page. 

9 Message Area—Area under the page title which displays messages as needed (shown 
outlined in blue).  

10 Page content area—The area of the page where tasks are executed (shown outlined in red). 
These vary and may include a number of different elements, which are described in the next 
sections. 

11 Legal Links—This area at the bottom left of each page contains links to applicable legal 
notices, privacy rights and terms of use.  
Contact Us—Opens a page of contact information (local road, Railinc support). 

12 Copyright—This area at the bottom right of each page displays copyright information. 
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Umler-Specific Interface Elements 
This section describes the Umler-specific interface elements. 

Umler Application Menu 
Exhibit 4 show the Umler application menu. 

Exhibit 4. Umler Application Menu 

 
 
The Umler application menu provides the following functions: 

Exhibit 5. Umler Application Menu Functions 
Menu Item Function 
Home Displays the Umler Home page 
Query Displays the Query menu 
Maintenance Displays the Maintenance menu 
Upload/Download Displays the Upload/Download menu 
Railinc Admin Functions Displays the Railinc Admin Functions menu (for Railinc 

Administrators only) 
Account Administration Displays the Account Administration menu (for Company 

Administrators only) 
Contact List Opens the FindUs.Rail application 
Component 
Tracking/Registry 

Displays the Component Registry menu as described in the 
Component Tracking User Guide (also see References) 

References Opens the Umler product page in Railinc.com 

 
Umler Checkbox Toggles 
On certain pages, Umler uses a checkbox to modify the appearance or display of data. 
Unchecking the checkbox returns the data to its default appearance. These include: 

 Use Spanish for error messages and form labels—check to toggle to Spanish language 
(Exhibit 8) 

 Show database values—check to show unformatted database values (Exhibit 16) 

 Flat View—check to display truck components grouped by element in location order (Exhibit 
16) 

 Differing elements only—check to removing matching elements (Exhibit 73) 

 

https://public.railinc.com/sites/default/files/documents/ComponentTracking_UG.pdf
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Umler Command Buttons 
Umler uses some application-specific command buttons. 

Exhibit 6. Umler-Specific Command Buttons 

Name Function 
Accept Accepts a pending access right granted by another company (Exhibit 223). 
Add Equipment 
Right 

Opens the Equipment Access Right page (Exhibit 200). 

Add Inspection 
Right 

Opens the Inspection Access Right page (Exhibit 203). 

Add Pool Right Opens the Pool Access Right page (Exhibit 198). 
Add View 
Confidential 
Data Right 

Opens the View Confidential Data Access Right page (Exhibit 220). 

Assign to 
Profile 

Opens the Manage Security Profiles (Exhibit 208). 

Assign to User Opens the Intra-Company User List (Exhibit 225). 
Clone Clones an existing security management profile (Exhibit 208). 
Clone Rights  Selects the user whose rights are being cloned. (Exhibit 206) 
Clone Rights 
from Another 
User 

Opens the Select Access Right Source page (Exhibit 206). 

Collapse All Causes table structure to collapse to headings only. Used with + and – 
icons. 

Confirm Clone 
Rights 

Applies cloned rights to the recipient (user) (Exhibit 207). 

Count 
Equipment 

Provides an equipment count for rights being assigned to a user. 

Decline Declines a pending access right granted by another company (Exhibit 
223). 

Element 
Selection 

Toggles back to the Select Elements for Update page for Modify Multiple 
Equipment Units (Exhibit 96). 

Expand All Causes table structure to expand to headings and subheadings only.  
Go While in view by location after incrementing the component count, adds 

an additional component location (Exhibit 92). 
Grant Access 
Rights 

Opens the Update Access Rights page for the selected company  
(Exhibit 218). 

Grant Profiles Opens the Manage Security Profiles page for the selected company  
(Exhibit 221). 

Relinquish Surrenders a previously accepted right from another company (Exhibit 
224)  

Restore Restores (activates) a deleted notice (Exhibit 173 and Exhibit 174). 
Revoke Revokes access right granted to another company (Exhibit 218) or a 

security profile granted to another company (Exhibit 221). 
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Name Function 
Show 
Equipment 

Shows list of equipment assigned to a specific pool (when viewing a pool 
header). See Exhibit 47. 

Switch View Toggles Equipment details page (e.g., modify, etc.) to show components 
by physical location on car (Exhibit 91 and Exhibit 92). 

Transfer Requests (and confirms) the transfer of specified access rights from one 
company to another (Exhibit 244). Railinc Administrators only. 

 
Umler Icons and Indicators 
Umler uses application-specific icons and indicators to assist you: 

Exhibit 7. Umler-Specific Icons 
Icon Umler-Specific Description 

 ETC Generation field 
 Mandatory Element field 
 Rating field 
 Identifies blue card elements 
 Element in conflict indicator. Record needs attention to remove the conflict 
 Copy entry in field to all fields below (notably for Inspections), or change query results 

display order (move selected item down) 
 Move entry into field at right (Query Output Attribute options) 
 Move entry into field at left (Query Output Attribute options) 

 Change query results display order (move selected item up or down) 
 Assigns selected security profile to user ID 
 Assigns all available security profiles to user ID 
 Unassigns selected security profile from user ID 
 Unassigns all security profiles from user ID 

+ Expands directory (table) structure 
- Collapses directory (table) structure 
 Opens calendar for date fields 
 Calculates due date for related date fields (Inspections). 
 Copy entry in field to all fields below (in Modify Multiple Equipment) 
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Getting Started 
The Umler application is accessed using the Railinc Single Sign-On (SSO), which can be 
accessed from the Railinc portal at https://public.railinc.com. The SSO log in is located at the 
upper right of the page. Refer to Register to Use Railinc SSO. 

Register to Use Railinc SSO 
 Each Umler user must register to use Railinc Single Sign-On. It is beyond the scope of this 
document to describe the use of Railinc Single Sign-On. Refer to Railinc SSO and Launch Pad 
User Guide. 

Once SSO registration is complete, you must request access to Umler within SSO.  

Requesting Umler Access 
After authorization to use Railinc SSO is received, you must request general access to Umler 
following instruction in the Railinc SSO and Launch Pad User Guide. 

When you receive the email notification that you have access to Umler, you can login and begin 
using Umler. Refer to Logging In. 

Access to certain functions within Umler are handled by your local Umler administrator who has 
the SSO rights to specify local Umler user’s tasks (and menu items). Some advanced Umler tasks 
are billable from Railinc to the requesting road, so access is carefully controlled via SSO. 
 

Logging In 
 Use the following procedure to log into Umler: 

1. Open your internet browser and enter https://public.railinc.com to open the Railinc website. 

2. Select the Customer Login link in the upper right of the page. The Account Access page is 
displayed. 

3. Enter your User ID and Password. Select Sign In. The Railinc Launch Pad is displayed. 

4. Select Umler in the My Applications section.  

a. If you are authorized to act on behalf of just one company, the Umler Home/Welcome 
page is displayed (Exhibit 8). 

b. If you are authorized to act on behalf of more than one company, the User Mark 
Selection pop-up displays (Exhibit 2). Enter or select the company you want to represent 
and click the Select button. The Umler Home page is displayed (Exhibit 8). 

https://public.railinc.com/
https://public.railinc.com/sites/default/files/documents/SSOUserGuide.pdf
https://public.railinc.com/sites/default/files/documents/SSOUserGuide.pdf
https://public.railinc.com/sites/default/files/documents/SSOUserGuide.pdf
https://public.railinc.com/
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Logging Off 
If the SSO Login is still needed for other SSO applications, select the Launch Pad link, which 
closes Umler and returns to the Launch Pad/SSO Welcome page where other applications can be 
selected.  

On any Umler page, select the Sign Out link at the upper right of the page. The Railinc SSO 
login page is displayed. 

Home Page 
Exhibit 8. Umler Welcome/Home 

   
Functions on this page include:  

• Check the box under the information window to view error messages, page titles, 
instructions, and command buttons in Spanish. 

• Select an Umler application menu item (refer to Exhibit 5). 

• Use the Single Equipment Search function as described in Single Equipment Search. 

• View/update equipment in conflict by selecting the Equipment units in conflict link. 
See View/Update Equipment Units in Conflict. 

• View/Accept/Reject Equipment Validation Requests by selecting the Equipment 
Validation Requests link.  See Equipment Validation Requests.  

• Send an email to your company (MARK) Umler contacts. 

• Search for other company’s contacts. 
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Single Equipment Search 
While on the Home/Welcome page, type an equipment ID in the Single Equipment Search text 
box and select Search. The Single Equipment Search page is displayed (Exhibit 9). 

Exhibit 9. Single Equipment Search 

 
 

 

This page is for viewing only. Select the Search tab to perform another search. 

To exit the page, select Done to return to the Home/Welcome page, or select an Umler 
application menu item (refer to Exhibit 5). 

View/Update Equipment Units in Conflict 
When the Equipment Units in Conflict link is selected, a query with those units is automatically 
executed (Exhibit 10). 
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Exhibit 10. Equipment Units in Conflict Auto Query 

 

Use the Equipment ID link to display the unit or select the checkbox beside the unit(s), and if 
authorized, choose Modify Equipment from the Action drop-down to edit those units in conflict. 
Refer to Exhibit 31. Refer also to Modify Single Equipment for modification instructions. 

Equipment Validation Requests 
When the Equipment Validation Requests link is selected on the Umler Home page (Exhibit 8), 
the list of Equipment Validation Requests opens. These equipment IDs are associated with your 
MARK(s) and Equipment Validation Requests records have been created for them based on four 
consecutive ‘Bad’ readings, Mismatched AEI Tag Detector readings and Umler information for 
Axle Count and or Equipment Group of that equipment. 

 

When an Equipment Validation Request is created on active equipment, an Umler 
Tickler notification should be created and sent to the equipment (car) owner for the 
equipment. See Configure Ticklers for details. 

 
Exhibit 11. Equipment Validation Request 
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View Equipment Validation Requests 
 
An active Equipment Validation Request record is created when: 

• Detectors log 4 or more bad reads for Axle Count (A024) when comparing equipment to 
Umler data 

• Detectors log 4 or more bad reads for AEI tag mismatch of Equipment Group (0002) 

An Equipment Validation Request record is moved to History when: 
• Records in Umler are Accepted or Rejected 
• A record is older than 90 days and no action has been taken 

An Equipment Validation Request record is deleted when: 
• Detectors log 3 or more good reads (following 4 or more bad reads) 
• A record is deleted from History after 90 days, see View History. 

The Equipment ID link opens the Display Unit page with the equipment details.  For more 
information about Display Unit, see Exhibit 16. 

Accept/Reject Validation Requests 
 
User the follow procedure to accept/reject equipment validation requests: 
 

1. Select the Equipment ID by clicking the appropriate checkbox(es).   

2. From the drop-down list in the upper right side of the page, select Accept or Reject from 
the list.  Click OK. 

a. Selecting Accept means that you have corrected the issue, whether it required a 
manual update in the Umler Modify Equipment page or fix of the AEI tag. 

b. Selecting Reject means that the equipment or tag has already been corrected or is 
not a validation issue. 

View History 
 
Click the View History link to view the history of all equipment IDs that have been Accepted or 
Rejected or are older than 90 days without any action being taken.    

 
Exhibit 12. Equipment Validation Request History 
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Email Umler Administrators for MARK 
To email an Umler administrator for the login mark, select the name link in the contact column. 
An email for that administrator is opened. Indicate the Umler needs and send the email. 

Find Other Company Contacts 
When the Click here link at the bottom of the Home page is selected, the FindUs.Rail application 
opens. Refer to Contact List for additional information. 
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Query 
When Query is selected from the Umler menu, the Query menu displays (Exhibit 13). 

Menu & Options 
Exhibit 13. Query Menu 

 

Exhibit 14 describes the tasks available in the Query menu. 

Exhibit 14. Query Menu Items and Descriptions 

Menu Item Description 
Display Unit Allows you to view the entire Umler record for a specified equipment ID. 

Equipment Query Allows you to query for equipment unit information. Provides access to saved 
queries. 

Car Management 
Query 

Allows you to search for specific pools and equipment in order to view pool 
header and assignment data and perform edits. 

Transaction Log The transaction log provides a history of all activity (related to equipment and 
pool data) successfully applied to the system. This page provides a search engine 
that allows you to query transaction records by various criteria such as transaction 
type and equipment group.  You can view the details of found transaction records. 

Inspection History Allows a user to request inspection history of equipment or by inspection types. 
Historical Lineage 

Query 
Allows a user to request and view a lineage query for a single piece of equipment. 

Equipment Unit 
Comparison 

Allows a user to view the differences between any two pieces of equipment in the 
same equipment category. 
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Display Unit 
This function is used to view all details of an Umler record for a specified equipment ID.  Based 
on user permissions, some confidential fields may not be displayed.  

Use the following procedure to display a record: 

1. From the main menu, select Query > Display Unit. The Display Unit page is displayed 
(Exhibit 15). 

Exhibit 15. Display Unit 

 

2. Enter a valid Equipment ID and select Submit. If the Equipment ID is not valid, an error 
message is displayed, otherwise the Display Unit Search Results (read-only) page is 
displayed (Exhibit 16). 

 
Exhibit 16. Display Unit Search Results – Default Expanded View 

 

• Scroll the table using the scroll bar or the navigation links above the table 
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• Use the Collapse All button to collapse the table to headings only (Exhibit 17): 

– General 
– Weight 
– Dimension 
– Specification 
– Feature 
– Cost 
– Blue Card (locomotive only) 
– Car Management 

– Train Service 
– Truck Components 
– Draft System Components 
– Unit Segment Components 
– Intermodal 
– Miscellaneous 
– Inspection 
– Default Presentation Group 

 

• Use the Expand All button to fully expand the table. 

• Use the + and - icons beside the headings to open or close them individually. 

• Check Show database values to see unformatted database values (this is a toggle—
uncheck to return to the formatted view). 

• Check Flat View to see Components grouped by similar element for easier comparisons 
(Exhibit 18). 

• Select the Equip PDF link to open a printable version of the record in another 
window/tab. The PDF can be saved or printed. To return, close the PDF window/tab. 

• Select the Equipment Health View link to open the Equipment Health View (EHV) 
portal (see the Equipment Health View User Guide for details). 

• For locomotives, select the Blue Card PDF link to display a PDF version of a blue card 
Locomotive Inspection and Repair Record (see Create Blue Card PDF). 

• Select the Search tab to submit a different Equipment ID.  
 

Exhibit 17. Display Unit Search Results – Collapsed View 

 

https://public.railinc.com/sites/default/files/documents/EHV_UG.pdf
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Exhibit 18. Display Unit – Flat View 

 

The same elements (e.g., B252) are listed in component location order (B-brake end, C-middle 
component, D-next component, and A-nonbrake end). 

 
When finished viewing the record, select Cancel, or select another Umler application menu item 
(refer to Exhibit 5). 

Create Blue Card PDF 
For locomotives, the Display Unit Search Results page contains an additional link to create a Blue 
Card PDF.  

Use the following procedure to display a Blue Card PDF: 

1. From the main menu, select Query > Display Unit. The Display Unit page is displayed 
(Exhibit 15). 

2. Enter the appropriate Equipment ID of a locomotive and select Submit. The Display Unit 
Search Results page for a locomotive is displayed (Exhibit 19). 
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Exhibit 19. Display Unit Search Results for a Locomotive 

 
3. Select the Blue Card PDF link. The Blue Card PDF downloads to your machine and is 

displayed as a PDF (Exhibit 20). 
 

Exhibit 20. Blue Card PDF 
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4. Where appropriate, use the options with the PDF Viewer to print the Blue Card. 
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Equipment Query 
The Equipment Query allows you to search for equipment unit information. You can also save queries 
to be used again later. Choosing unique or precise criteria provides results in less time. If looking 
for a single equipment with limited information, consider the Single Equipment Search on the 
Umler Home page (refer to Single Equipment Search). 

Use the following procedure to search for equipment: 

1. From the main menu, select Query > Equipment Query. The Equipment Query page is 
displayed (Exhibit 21 and Exhibit 24). 

Exhibit 21. Equipment Query – Top  

 

The third tab at the top of the page shows saved equipment queries. See Viewing Saved Queries 
and Save Query. 

2. Enter the appropriate search criteria. At least one search parameter is required to perform a 
search. *Red fields are mandatory. 

Field Descriptions for the top of the page are shown in Exhibit 22: 

Exhibit 22. Equipment Query Field Descriptions 

Field Description 

Equipment ID(s) Enter the specific equipment ID and number (e.g., ABCD123) or search 
with a range (e.g., ABCD123-999) or a wildcard. See Exhibit 23 for more 
information. 
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Field Description 

Pool ID 
 

Type a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), positions 4 through 
7 are pool IDs assigned by the pool operator. Input the specific Pool IDs or 
search with a range or a wildcard. See Exhibit 23 for more information. 

Search for all unassigned equipment using pool ID = 0000000. 
Equipment Group(s) Used to indicate the general equipment group being sought. Valid values: 
 • Box 

• Gondola 
• Hopper 
• Tank 
• Flat 

• Intermodal Flat 
• Vehicular Flat 
• Chassis 
• Container 
• Trailer 

• Steel Wheel Set 
• Locomotive 
• Passenger 
• Misc 
• EOT Device 

Equipment Type Codes 
 

To Query by complete codes, select the Query by complete codes radio 
button and enter the complete code (e.g., M500) in the single blank input 
field. To Query by partial codes, select the Query by partial codes radio 
button, and use the four drop-down fields displayed to select partial code 
values (one alpha and three numeric). 

 

Mechanical 
Designation(s) 

Alphabetic AAR code assigned to the physical description of the unit. See 
the Umler Data Specifications Manual. 

*Include Equipment 
Restricted in 
Interchange 

This option allows you to choose to include or not include restricted 
equipment in an interchange. Restricted equipment units are those in a 
conflict status. Default is Yes. 

EIN(s) Equipment Identification Number. Uniquely identifies equipment in 
Umler. If equipment is restenciled (new Equipment Initial and Number) it 
retains its original EIN (unless equipment is rebuilt with new built date). 

Company-Specific 
Equipment Group(s) 

Company-Specified Equipment groups are private pools of equipment that 
are only available to the company specified. Refer to Company-Specific 
Equipment Groups. 

 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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Exhibit 23. Equipment ID Formats/Delimiters/Wildcards 

Example Expected Outcome 
ABC 100, ABC 101, ABC 105 This range would include 3 IDs 
ABC 100–109 This range would include 10 IDs 
ABC 100–109, ABC 112, ABC 120–129 This range would include 21 IDs 
ABC100,121,132 Equipment Initials is optional in a range 
ABC100–110,121,132 Dash and commas can be combined without Equipment Initials in a 

range. This range has 13 IDs 
ABC 200 
ABC 204 
ABC 208 

New line is a acceptable delimiter in any of the formats above 

ABC 300;ABC 304;ABC 306  Semi-colon is an acceptable delimiter in any of the formats above 
ABC 300.ABC 304.ABC 306  Dot is an acceptable delimiter in any of the formats above 

ABC 000000000* Wild card Character is *. This range will have 10 IDs 
Valid Delimiters: • Dot 

• Colon 
• Semi-colon 

• Comma 
• New line/Carriage Return 

• Single quote 
• Space (with solid IDs only)  
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Exhibit 24. Equipment Query – Bottom  

 

Field Descriptions for the bottom of the page are shown in Exhibit 25: 

Exhibit 25. Equipment Query Field Descriptions (cont’d) 

Field Description 

Equipment Initials The initials stenciled on the specified equipment. 
Umler Owner The Umler owner of the specified equipment. 
Umler Company The parent company that owns the specified equipment. 
Lessee The company leasing the specified equipment. 
Stenciled Mark Owner The stenciled mark owner for the specified equipment. 
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Field Description 

Status/No Status To search by specified equipment statuses, select the Status radio button 
and then the appropriate status types listed (Active, Inactive or Pre-
registered). Select the No Status radio button to search for equipment 
without a status. Otherwise, the default is all statuses. 

Confidential Element 
Search (up to three 
allowed) 

 

The Element Name drop down allows 
you to restrict your equipment search to 
a specific element. The complete list is 
not shown. 

 

 

From the Qualifier drop-down list, 
select the Boolean operator to be used in 
combination with the entered Element 
Values. Select Between to obtain results 
using two input values (e.g., weight 
range, date range). 

 Compare to another element—INSERT 
 Element values—This may be a height, length, width, weight, or other 

number, Yes/No, etc. If a date, a format hint is provided (YYYYMMDD) 
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Field Description 

Element Value Criteria 
(up to three allowed)  

 

The Element Name drop down allows 
you to restrict your equipment search to 
a specific element. The complete list is 
not shown. 

 

 

From the Qualifier drop-down list, 
select the Boolean operator to be used in 
combination with the entered Element 
Values. Select Between to obtain results 
using two input values (e.g., weight 
range, date range). 

 Compare to another element—INSERT 
 Element values—This may be a height, length, width, weight, or other 

number, Yes/No, etc. If a date, a format hint is provided (YYYYMMDD) 
 

Example – How to Use Element Value Criteria/Values to View Conflicts:  
a. Select Date of Original Conflict from the Element Name drop-down. 
b. Select Greater than or Equals from the Qualifier drop-down. 
c. Enter 20230101 in the Element Values field. 

 
3. Select the Browser format to have the search results displayed in the browser (default). 

Otherwise, select CSV (comma separated values).  

4. (For browser only) Set the *Maximum Number of Results field to the maximum number of 
result records to be returned (100, 500, 1000). Default is 1000. 

5. (Optional) Select the Customize Query Output tab to specify what data attributes should be 
included in the results displayed, and how those results should be sorted. See Exhibit 26. 
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Exhibit 26. Equipment Query – Customize Query Output Tab 

 

a. To add one or more attributes to Selected Attributes list, select from the Available 
Attributes and select the right pointing arrow (outlined in red above). For multiple 
selection, press Ctrl while making selections to move multiple attributes at one time.  

b. To remove one or more attributes, select from the Selected Attributes list and select the 
left pointing arrow (outlined in red above).  

c. Choose the up and down arrows (outlined in red above) to adjust the order of the output. 
The top attribute appears as the first (left) column in the results table. 

d. (Optional) Use the Sort By fields to sort results for any attributes included in the results. 
The first Sort By is the primary sort. The other two Sort by fields are the secondary sort 
and the tertiary sort. The default sort is the first three attributes listed in ascending order. 
In Exhibit 26, you might want the data sort by Lessee as a primary sort (to get potential 
contacts clustered together in the output). Lessee would then be selected for the first Sort 
By attribute. 

e. If needed, select the Basic tab to return to the main query input page. 

6. Verify all criteria and output options have been specified, as shown in Exhibit 27, Exhibit 28, 
and Exhibit 29. 
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Exhibit 27. Equipment Query Example – Top 

 



Umler® Query | Equipment Query     
  

 
     

Revised January 2024 36 Umler Version 6.0 

Exhibit 28. Equipment Query Example – Bottom  

 



Umler® Query | Equipment Query     
  

 
     

Revised January 2024 37 Umler Version 6.0 

Exhibit 29. Equipment Query Example – Customize Query Output 

 

7. Select one of the processing options shown in Exhibit 30. 

Exhibit 30. Query Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See View 

Query Results and Export Query Results to CSV. 
Count Executes the search and outputs a single line message with the count of records 

meeting the specified criteria. See Exhibit 34. 
Save Saves the query. Opens the Save Query Attributes panel (Exhibit 36). 
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View Query Results 
If Browser was selected for output, and Search selected, the Equipment Query Results page is 
displayed (Exhibit 31). 

Exhibit 31. Equipment Query Results 

 

View Details 
To view details for a particular equipment, select its Equipment ID Link. The Display Unit 
Search Results page is displayed (refer to Exhibit 16). Select Cancel on the detail page to return 
to the query results. 

Revising a Search 
While viewing search results online, select the Search Criteria tab to modify search criteria 
values and then resubmit. 

Requesting Other Actions 
Other actions can be taken for selected equipment by selecting an action from the drop-down list 
(partial list show in Exhibit 31) and selecting Apply. The various actions are described in other 
sections of this guide. 

• Add to Pool (refer to Exhibit 128) 
• Air Brake Test (refer to Exhibit 131) 
• Autorack Certification (refer to Exhibit 131) 
• Autorack Inspection (refer to Exhibit 131) 
• Autorack Repair (refer to Exhibit 131) 
• Car Grade Inspection (refer to Exhibit 131) 
• Change Equipment Group (refer to Exhibit 102) 
• Clone Equipment 
• Delete Equipment 
• Door Lube Inspection (refer to Exhibit 131) 
• Locomotive Air Brake Inspection (refer to Exhibit 131) 
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• Locomotive Annual Inspection (refer to Exhibit 131) 
• Locomotive Cab Signals Inspection (refer to Exhibit 131) 
• Locomotive Inspection Due Date Update (refer to Exhibit 131) 
• Locomotive Quarterly Inspection (refer to Exhibit 131) 
• Locomotive RCL Inspection (refer to Exhibit 131) 
• Locomotive Storage Event (refer to Exhibit 131) 
• Modify Equipment (refer to Exhibit 91) 
• Reflectorization Event (refer to Exhibit 131) 
• Remove from Pool (refer to Exhibit 129) 
• Remove Lessee (refer to Exhibit 118) 
• Send to Conflict Check (for Railinc Administrators only) 
• Update Equipment Maintenance Party (refer to Exhibit 107) 
• Update Equipment Management Codes (refer to Exhibit 120) 
• Vehicular Flat Car Certification (refer to Exhibit 131) 

Export Query Results to CSV 
Downloading the File 
If you choose CSV file for output, the browser will automatically download and save the file to 
the file of your choice or the Downloads folder on your computer (Exhibit 32). 

Exhibit 32. File Download for CSV Output 

 

• When the file is opened, the output appears as shown in Exhibit 33. 

Exhibit 33. CSV Query Output in MS Excel 
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Request Counts for Query 
When Count is selected, the query is executed, but only the number of records matching the 
criteria is displayed (Exhibit 34). No details are provided. This can be used to provide counts to 
purchasing departments for parts ordering, scheduling inspections, or estimating vendor service 
needs, etc. 

Exhibit 34. Equipment Query With Count 

 

If additional details are needed, select Search to execute a normal query. 

Viewing Saved Queries 
When the Saved Queries tab is selected, the Saved Queries page is displayed (Exhibit 35). 

Exhibit 35. Saved Queries Tab 
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Select the Name link to use values saved in that query. Selecting table heading links sorts by that 
field. Select the Delete button in the Action column to delete a saved query. By default, users see 
their own queries, but can check the All Saved Queries radio button to view all for their 
company. 

Save Query 
Queries that might be used again can be saved by selecting Save at the bottom of the Equipment 
Query (Exhibit 28). Saving queries helps save input time and ensures consistent results (e.g., 
doing the same query across several roads). When Save is selected, the Save Query Attributes 
page is displayed (Exhibit 36). 

Exhibit 36. Save Query Attributes 

 

Enter the name of your query in the Query Name field. Optionally, enter a description in the 
Query Description field that will help you find it later. Select Save. The query is saved, and the 
“Query saved successfully” message is displayed at the top of the page. 

Reuse a Query 
To reuse a saved query, select the Saved Queries tab. Select the Name link. The page (all tabs, if 
used) is populated with the saved query. Make required changed (e.g., date changes, or railroad 
changes, etc., and select a processing option (Exhibit 30). 

Delete a Query 
To delete a saved query, select the Saved Queries tab, and select the Delete button to the right of 
the query in the Action column. 
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Car Management Query 
The Car Management Query function is used to search for specific pools and equipment in order to 
view pool header and assignment data and perform edits. 

Equipment View 
 Use the following procedure to run a Car Management Query: 

1. From the main menu, select Query > Car Management Query. The Pool/Equipment Search 
page is displayed (Exhibit 37). 

Exhibit 37. Pool/Equipment Search 

 

2.  From the View drop-down list, choose Equipment View for equipment management. 
Otherwise, leave set to Pool View for pool management (for Pool View, see Pool View). 
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3. Enter the appropriate search criteria. At least one search parameter is required to perform a 
search. 

 
Using both Equipment IDs and Pool IDs is not allowed. Specify one or the other. 

 
Field Descriptions for the page are shown in Exhibit 38: 

Exhibit 38. Car Management Query Field Descriptions 

Field Description 

Company-Specific 
Equipment Group(s) 

Company-Specified Equipment groups are private pools of equipment that 
are only available to the company specified. Use the search icon  
( ) to open the Company-Specific Equipment Group Lookup pop-up 
(Exhibit 147). Refer to Company-Specific Equipment Groups. 

Pool ID Enter a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), and positions 4 
through 7 are pool IDs assigned by the pool operator. Input the specific 
Pool IDs or search with a range or use a wildcard. See Exhibit 23 for more 
information. 

Search for all unassigned equipment using pool ID = 0000000. 
Description General description of the pool (20 characters max). 
Reporter Assigned alphabetic reporting mark of the carrier reporting for non-

mechanized operators that have made such an agreement with the reporting 
road (4 characters max). 

Operator Assigned alphabetic reporting mark of the actual operator of a specific pool 
(4 characters max). 

Loading Location The actual shipper loading point or plant location or railroad holding point.  
Must be a valid SPLC location (19 characters max). Use the search icon  
( ) to open the Station Lookup page (Exhibit 39). 

State/Province Indicates the state or province where the pool is located. This is 
automatically populated with Pool/Equipment Search Results. 

Pool Type Code Used to identify a type of railroad pool assignment: 

C = Equipment assigned to a specific shipper at a specific location 
G = Contaminated cars 
J = Equipment assigned to an agent 
N = Similar to the C Pool, except, the equipment is not assigned to a 

specific shipper or loading point (National Pools). 
O = Equipment assigned to Recall pools 
P = Pool comprised of equipment assigned to accommodate a specific 

commodity. 
T = Pool comprised of equipment assigned to an agent.  

Extended Description More detailed description of the pool (80 characters max). 
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Field Description 

EIN(s) Equipment Identification Number. Uniquely identifies equipment in 
Umler. If equipment is restenciled (new Equipment Initial and Number) it 
retains its original EIN (unless equipment is rebuilt with new built date). 

Equipment ID(s) Enter the specific equipment IDs (e.g., ABCD123) or search with a range 
(e.g., ABCD123-999 or a wildcard). See Exhibit 23 for more information. 

Equipment Group(s) Used to indicate the general equipment group being sought. See Equipment 
Group(s) in Exhibit 22. 

Equipment Type 
Code(s) 

Alphanumeric code (one alpha and three numeric) used to designate a 
specific type of equipment and attributes. 

Mechanical Designation Alphabetic AAR code assigned to the physical description of the unit. See 
the Umler Data Specifications Manual. 

 
Station Lookup 
When the search icon is selected for either Location field, the Station Lookup page is displayed 
(Exhibit 39). 

Exhibit 39. Station Lookup 

 

a. Select a qualifier for the Location. Valid values include: 

• Begins With 
• Contains 
• Ends With 
• Exact Match 

b. (Optional) Select one State/Province from the drop-down list. 

c. (Optional) Enter a known SCAC in the SCAC field. 

d. Select Search. The Station Lookup page is displayed (Exhibit 40). 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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Exhibit 40. Station Lookup Results 

 

e. Select the radio button beside the correct location and the Select button. The 
Pool/Equipment Search page is redisplayed (Exhibit 37) with the location and 
State/Province field showing the selection. 

4. Select the CSV format from the drop-down list if needed, or leave it set to Browser (default).  

5. Select a *Maximum Number of Results (1000 is default). 

6. Select one of the following processing options: 

Exhibit 41. Car Management Query Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See Browser 

Output or CSV Output. 
Count Executes the search and outputs a single line message with the count of records meeting 

the specified criteria (similar to Exhibit 34). 
Reset Clears data and returns fields to the default setting. 

 
7. View either Browser or CSV output results (Exhibit 42 or Exhibit 43). 
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Browser Output 
If Browser was selected for output, results appear as shown in Exhibit 42. 

Exhibit 42. Pool/Equipment Search Results – Equipment View 

 

Abbreviations used for the column headings at the top of the results table include: 

• EG = Equipment Group 
• ETC = Equipment Type Code 
• MD = Mechanical Designation 
• UR = User Empty Routing Instruction 
• SG = System Empty Routing Instruction 
• PC = Pool Control 
• MR = Mechanical Restriction 
• MRR = Mechanical Restriction Reason 
• TC = Umler Transportation Code 
• TCC = Umler Transportation Condition Code 

To view details for a particular equipment, select its Equipment ID link. The Display Unit 
Search Results page is displayed (refer to Exhibit 16). Select Cancel on the detail page to return 
to the query results. 

To take actions for listed equipment, refer to Requesting Other Actions. 
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CSV Output 
If CSV was selected for output, results are saved to the Downloads folder of your computer and 
when opened, appears as shown in Exhibit 43.  

Exhibit 43. Pool/Equipment Search Results – CSV Results 

 

Pool View 
If you elect to search for a pool view, use query criteria as described in Equipment View, but 
leave the View drop-down list set to Pool View. Results can be to the browser or CSV (or a 
count).  

 

To view all pool headers, select Search without entering any criteria. When entering 
pool ranges, do not use a range larger than 10,000. 

 
Browser Output 
If Browser was selected for output, results appear as shown in Exhibit 44. 

Exhibit 44. Pool/Equipment Search Results – Pool View 
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Currently, the only action available from this page is Delete Pool. To delete a pool header, check 
the boxes beside the pools to be deleted and select the Apply button. See Delete Pool Header for 
more information. 

To view a pool header, select its link. The View Pool Header page is displayed (Exhibit 45). 

Exhibit 45. View Pool Header 

 

Select one of the following options: 

Exhibit 46. View Pool Header Processing Options 
Show Equipment Opens the Assigned Equipment page for viewing (Exhibit 47). No 

actions are available on this page. Select Done to return to the View 
Pool Header page. To remove individual equipment from a specific pool, 
use either an Equipment Query or a Car Management Query (Equipment 
View) with the Pool ID as criteria.  

Edit Opens the Update Pool Header page (Exhibit 48). See Update Pool 
Header. 

Done Returns to the search results page (Exhibit 44). 
 
Exhibit 47. Assigned Equipment 
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Update Pool Header 
After a pool view query is performed, a pool ID link selected, and a pool header is being viewed: 

1. Select Edit. The Update Pool Header page is displayed (Exhibit 48). 

Exhibit 48. Update Pool Header 
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2. Update fields as needed. Refer to Exhibit 116 for field descriptions. 

3. (Optional) Choose the Future radio button to delay the pool addition to a future date. The 
page expands with an On Future Date field. 

Exhibit 49. Future Date Fields 

 

 

Pool-related actions assigned a future date can be modified. See Manage Future 
Transactions. Future date must be from 2 days (48 hours) to a maximum of 30 days. 

 
a. Use the calendar picker ( ) to select the future date. 

b. (Optional) Add a Transaction Description to make the future work easier to identify when 
using the Maintenance > Manage Future Transactions function. 

4. Select one of the options shown in Exhibit 50.  

Exhibit 50. Update Pool Header Processing Options 
Validate Validates data before submission to facilitate error correction.  
Submit Send the data to the system. Validation occurs first, so error correction can be done. 

If successful a message similar to Exhibit 139 is displayed. After successful 
submission of changes, select OK to return to the query list.  

Suspend Saves the edit input for completion later. Opens the Suspend Work page (similar to 
Exhibit 82). See Suspended Work to resume the Pool Header Edit task. 
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Transaction Log 
The Transaction Log function allows users to see a list of transactions for specified criteria (e.g., 
date range, user ID, Equipment IDs, Pool IDs, transaction types, etc.). 

Use the following procedure to view a transaction log: 

1. From the main menu, select Query > Transaction Log. The Search Transaction Log page is 
displayed (Exhibit 51 and Exhibit 53). 

Exhibit 51. Search Transaction Log – Top 

 

2. Enter the appropriate search criteria.  At least one search parameter is required to perform a 
search. Mandatory fields are indicated with an asterisk (*) and red font. 

Field descriptions for the top of the page are shown in Exhibit 52. 
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Exhibit 52. Transaction Log Field Descriptions 

Field Description 

Format Select the CSV format from the drop-down list to have results 
saved/displayed as a CSV file. The default selection is Browser.  

*Maximum Number of 
Results (Browser 
Output Only): 

Maximum number of result records you want returned (100, 500, 1000, 
5000). Default is 1000. 

*Starting and Ending 
Date/Time 

Search for transactions occurring between the specified starting date/time 
and the specified ending date/time. Remember to select either AM or PM 
with the available radio buttons. Defaults are: 
• Starting Date/Time: 12:01 AM of the previous day’s date 
• Ending Date/Time: 11:59 PM of the current day’s date 

Check Search All Dates to ignore date criteria. 
All notice times are recorded in Eastern Time.  

*Equipment ID(s) Enter the specific equipment IDs (e.g., ABCD123) or search with a range 
(e.g., ABCD123-999) or a wildcard. See Exhibit 23 for more information. 

*Company-Specific 
Equipment Groups 

Company-Specified Equipment groups are private pools of equipment that 
are only available to the company specified. Use the search icon  
( ) to open the Search for Company-Specific Equipment Groups page 
(Exhibit 147). Refer to Company-Specific Equipment Groups. 

Transaction Type(s) Search for transactions related to the following: Pool Header, Pool 
Assignment, Equipment Characteristics, Inspections and Car Grades. 

User ID(s) Search for transactions created by specific users by entering User IDs in 
this field. Separate multiple IDs using the delimiters shown in Exhibit 23. 
To search for intra-company user IDs, see Manage Intra-Company User 
Access Rights. 

State(s) Select either Normal or Nullified. Nullifying an event identifies it as 
having been submitted in error. Selecting Nullified finds transactions that 
had been nullified. 

Equipment Type 
Code(s) 

Search for transactions related to equipment with the specified equipment 
type code(s). For example, M500. 

Equipment Group(s) Used to indicate the general equipment group being sought. See Equipment 
Group(s) in Exhibit 22. 
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Exhibit 53. Search Transaction Log – Bottom 

 

Field descriptions for the bottom of the page are shown in Exhibit 54. 

Exhibit 54. Transaction Log Field Descriptions (cont’d) 

Field Description 

Pool ID Type a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), positions 4 through 
7 are pool IDs assigned by the pool operator. Input the specific Pool IDs or 
search with a range or a wildcard. See Exhibit 23 for more information. 

Search for all unassigned equipment using pool ID = 0000000. 
Mechanical 
Designation(s) 

Alphabetic AAR code assigned to the physical description of the unit. See 
the Umler Data Specifications Manual. 

Company ID(s) Search for transactions related to specified company ID(s). 
EIN(s) Equipment Identification Number. Uniquely identifies equipment in 

Umler. If equipment is restenciled (new Equipment Initial and Number) it 
retains its original EIN. 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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Field Description 

Element Value Criteria Two sets are provided (for Transaction and Previous values). 

• Use the drop-down 
list to select an 
Element Group 
(partial list shown): 

 

• Use the drop-down 
list to select an 
Element (available 
elements depend on 
the Element Group 
selected): 

 

• Enter a Transaction Value of a specific element qualifier or check the 
All Values checkbox without using a qualifier. 

Ownership Control 
Criteria 

Check one of the two radio buttons provided to for your results to match 
either: 

• Current ownership conditions – or –  
• Ownership conditions at time of transaction (default) 

Equipment Initials The initials stenciled on the specified equipment. 
Umler® Owner(s) The Umler owners of the specified equipment. 
Umler Company The Umler Company that owns the specified equipment. 
Lessee(s) The company leasing the specified equipment. 
Stenciled Mark 
Owner(s) 

The stenciled mark owners for the specified equipment. 

 
3. Select one of the following processing options: 

Exhibit 55. View Transaction Log Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See View 

Transaction Results Online or refer to Export Query Results to CSV for CSV file 
processing/viewing. 
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Count Executes the search and outputs a single line message with the count of transaction 
records meeting the specified criteria. Similar to Exhibit 34. 

Reset Clears data and returns fields to the default setting. 
 

View Transaction Results Online 
If Browser was selected for output, and Search selected, the Transaction Log Search Results 
page is displayed (Exhibit 56). 

Exhibit 56. Transaction Log Search Results 

 

To change criteria, select the Search Criteria tab, edit, and resubmit. 

To view details for a particular transaction, select its ID link (column at left). The Transaction 
Details page is displayed (Exhibit 57). Select Next to click through the list of IDs from the Search 
Results. Select Done on the detail page to return to the search results. 

To view contact information for the listed Company or User, select their respective links. See 
Exhibit 58 and Exhibit 59. Select Done to return to the Search Results page. 
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Exhibit 57. Transaction Details 

 

The actions available on this example page is to view the Company Contact information (Exhibit 
58), view User Contact Information (Exhibit 59) or select the Transaction ID to view the 
transaction that generated the one being viewed. 

Exhibit 58. Company Contact Info 

 

Exhibit 59. User Contact Info 
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Inspection History 
This function is used to view inspection history for a specified equipment ID or EIN.  

 
If the equipment’s built date has changed and a new EIN is generated, the inspection 
history will not include all inspections when searching by a particular EIN. 

 
Use the following procedure to view an inspection history for equipment units: 

1. From the main menu, select Query > Inspection History. The Search Inspection History 
page is displayed (Exhibit 60). 

Exhibit 60. Search Inspection History – Top 

 

2. Enter the appropriate search criteria. At least one search parameter is required in the first box 
to perform a search. Mandatory fields are indicated with an asterisk (*) and red font. 

Field descriptions for the top of the page are shown in Exhibit 61. 

Exhibit 61. Inspection History Field Descriptions 

Field Description 

Equipment ID(s) Enter the specific equipment IDs (e.g., ABCD123) or search with a range 
(e.g., ABCD123-999) or a wildcard. See Exhibit 23 for more information. 

EIN(s) Equipment Identification Number. Uniquely identifies equipment in 
Umler. If equipment is restenciled (new Equipment Initial and Number) it 
retains its original EIN. 
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Field Description 

Company-Specific 
Equipment Groups 

Company-Specified Equipment Groups are private pools of equipment that 
are only available to the company specified. Use the search icon  
( ) to open the Search for Company-Specific Equipment Groups page 
(Exhibit 147). Refer to Company-Specific Equipment Groups. 

Date/Time range Search for inspections occurring between the specified starting date/time 
and the specified ending date/time.  Remember to select either AM or PM 
with the available radio buttons. Defaults are: 

• Starting Date/Time: 12:01 AM of the previous day’s date 
• Ending Date/Time: 11:59 PM of the current day’s date 

Check Search All Dates to ignore date criteria. 
All notice times are recorded in Eastern Time. 

 
Exhibit 62. Search Inspection History – Bottom 

 

Field descriptions for the bottom of the page are shown in Exhibit 63. 

Exhibit 63. Inspection History Field Descriptions (cont’d) 

Field Description 

Inspection Types Select the inspection types wanted for the query. Multiple selections are 
allowed. 

User ID(s) Search for inspections recorded by specific users by entering User IDs in 
this field. Separate multiple IDs using the delimiters shown in Exhibit 23. 
To search for intra-company user IDs, see Manage Intra-Company User 
Access Rights. 

States Select Normal or Nullified (to see inspections that have been nullified via 
EDI messages). 

System generated Select the Yes or No radio button to include system generated inspection 
records. To clear both radio buttons, select Clear. 
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Field Description 

Voided Select the Yes or No radio button to display voided inspections. To clear 
both radio buttons, select Clear. 

Element Value Criteria One criteria set is provided. 

• Use the drop-down list to 
select an Element (partial 
list shown): 

 

• Enter a Transaction Value for the Element selected. 

*Output to Select Browser (Summary) or Browser (Detail) from the drop-down list. 
Default is Browser (Summary). CSV is not available for this form. 

*Maximum Number of 
Results 

Maximum number of result records you want returned (100, 500, 1000, 
5000). Default is 100. 

 
3. Select one of the following processing options: 

Exhibit 64. View Transaction Log Processing Options 
Search Executes the search and outputs to the Browser as requested. See View Inspection 

History Summary Results Online, or  
View Inspection History Detail Results Online. 

Count Executes the search and outputs a single line message with the count of inspection 
records meeting the specified criteria. Similar to Exhibit 34. 

Clear Clears entered data and resets fields to default. 
Cancel Leaves the form and displays the Umler Home page. 
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View Inspection History Summary Results Online 
When Browser (Summary) is selected as the output for a search, and the Search button is 
selected, the Inspection History Search Results page is displayed (Exhibit 65). 

Exhibit 65. Inspection History Search Results – Browser Summary 

 

To see details for an Equipment ID, select the Timestamp link in the first column. The detail 
page for that equipment is displayed (Exhibit 66). 

To export the results as a CSV file, select the CSV link at the lower left of the page (outlined in 
red). Refer to Export Query Results to CSV. 

Exhibit 66. Search Inspection History Summary Details 
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For some inspections, you’ll have the option to select Nullify to nullify the 
inspection/certification transaction if the transaction was erroneously reported.   

Select Done to return to the Search Results Summary page. 

View Inspection History Detail Results Online 
When Browser (Details) is selected as the output for a search, and the Search button is selected, 
the Inspection History Search Results (Browser Details) page is displayed (Exhibit 67). 

Exhibit 67. Search Inspection History – Detailed List 

 

To see details for an equipment, select the Timestamp link in the first column. The detail page 
for that equipment is displayed (Exhibit 66). Use the page arrows in the bottom right to move 
between many pages (30 listed per page).  

To export the results as a CSV file, select the CSV link at the lower left of the page. Refer to 
Export Query Results to CSV.  

Historical Lineage Query 
This function is used to view all unit identification (entry into system, restenciling, etc.) actions 
for a specified equipment ID or EIN. Based on user permissions, some confidential fields may not 
be displayed.  

 
If the built date has changed and a new EIN is generated, the inspection history will 
not include all inspections when searching by a particular EIN.  

 
Use the following procedure to view lineage for a unit: 
 
1. From the main menu, select Query > Historical Lineage Query. The Historical Lineage 

page is displayed (Exhibit 68). 
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Exhibit 68. Historical Lineage Query 

 

2. Enter a valid Equipment ID or EIN and select Search. The Historical Lineage Query 
Results page is displayed (Exhibit 69). 

Exhibit 69. Historical Lineage Query Results 

 

This example shows a car that changed ownership and was restenciled. The EIN remains the 
same throughout, but the Equipment ID changes. The most recent lineage action is at the top of 
the table. 

Select the Search Criteria tab to run another query or select another Umler application menu 
item (refer to Exhibit 5). 

 
Only one equipment record with the status of Active can exist in the EIN lineage. 
Having more than one equipment ID active for the same EIN may result in a 
duplicate EIN conflict status for all active records. 
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Historical Locomotive Blue Card Query 
This function is used to view the FRA Blue Card Locomotive Inspection and Repair Record for a 
specified Equipment ID by year.  

Use the following procedure to view the historical locomotive blue card for a unit: 

1. From the main menu, select Query > Historical Locomotive Blue Card Query. The 
Historical Locomotive Blue Card Query page is displayed (Exhibit 70). 

Exhibit 70. Historical Locomotive Blue Card Query 

 

2. Enter the Equipment ID, select the Year from drop-down list and select Submit. 
The Locomotive Blue Card for the Equipment ID selected opens in a new window. 

Exhibit 71. Historical Locomotive Blue Card Record 
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Equipment Unit Comparison 
This function is used to view a comparison of Umler records for two specified equipment units. 
This might be used to: 

• Ensure when an equipment changes ownership and operates for a period of time under 
both IDs, that the most recent information appears in the newest record (e.g., inspections 
or repairs done) 

• Help make a decision between two cars being considered for hire 

Based on user permissions, some confidential fields may not be displayed.  

Use the following procedure to view a comparison between units: 

1. From the main menu, select Query > Equipment Unit Comparison. The Equipment Unit 
Comparison page is displayed (Exhibit 72). 

Exhibit 72. Equipment Unit Comparison 

 

2. Enter the Equipment IDs to be compared in the two text boxes and select Submit. The 
Equipment Unit Comparison page displays with data for each unit shown side by side 
(Exhibit 73). 

 
Validation is optional but performed as part of the submit process. If either 
Equipment ID is invalid, an error message is displayed.  
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Exhibit 73. Equipment Unit Comparison Expanded 

 

Values for the two units appear in two columns with the Equipment ID at the top. Elements with 
different values are outlined and in a lighter color (yellow/orange). Component help ID links can 
be different if the cars are different types. Page navigation is similar to that described in Display 
Unit. 

Check Differing elements only to restrict the view—matching elements are removed from view 
(Exhibit 74). Uncheck to return to the regular view. 

Use the Collapse All and Expand All buttons to collapse or expand the table structure. 

Exhibit 74. Equipment Unit Comparison Differences Only View 

 

These pages are for viewing only. When finished viewing the comparison, select Cancel, or 
select another Umler application menu item (refer to Exhibit 5). 
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Maintenance 

 
To complete these tasks, you must have some rights assigned beyond query (Umler 
default permission). See your Company Umler Administrator for assistance. 

 
When Maintenance is selected on an Umler page, the Maintenance menu is opened 
(Exhibit 75). 

Menu & Options 
Exhibit 75. Maintenance Menu 

 

Exhibit 76 describes the tasks available on the Maintenance menu. 

Exhibit 76. Maintenance Menu Items and Descriptions 

Menu Item Description 
Add/Change/Delete Opens the Add/Change/Delete submenu.  
Car Management Opens the Car Management submenu.  

Inspections Opens the Inspections page, which allows you to report (or view) described 
inspections. 

Company-Specific 
Equipment Groups 

Opens the Company-Specific Equipment Group submenu. 

Notice Management Displays the Search for Notices page.  Allows you to search for notices based 
on detailed search criteria, view notices, fix errors related to notices, and 
suppress read, resolved, or unwanted notices. 

Suspended Work Open the Suspended Work page and tasks that have been saved “in progress” 
and allows you to select and resume work on a suspended task. 

Manage Future 
Transactions 

Displays the Search Future Effective Transaction page which allows you to 
search for and delete any future effective transactions. 
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Add/Change/Delete 
When Maintenance > Add/Change/Delete is selected, the Add/Change/Delete submenu is 
displayed. 

Exhibit 77. Add/Change/Delete Submenu 

 

Exhibit 78 describes the options on the Add/Change/Delete submenu. 

Exhibit 78. Add/Change/Delete Submenu Items and Descriptions 

Menu Item Description 
Add Equipment Allows a user to add a new equipment unit to Umler. 

Clone Equipment Allows a user to add single and multiple equipment units by cloning from an 
existing unit. 

Add-Back 
Equipment 

Allows a user to add an equipment unit back into active status from online Umler 
archives. 

Add-Back Multiple 
Equipment 

Allows a user to reactivate multiple equipment units at one time. 

Modify Single 
Equipment 

Allows a user to change elements for a single equipment unit. 

Modify Multiple 
Equipment 

Allows a user to change selected elements for several equipment units in one 
editing session. 

Single Restencil Allows a user to modify a record to reflect restenciling of the piece of equipment. 
Restenciling refers to the act of changing the equipment mark and number that is 
stenciled on the side of an equipment unit. 

Multiple Restencil Allows a user to restencil multiple cars sequentially or following a pattern. 

Change Equipment 
Group 

Allows a user to change an Umler Equipment Group for a single equipment unit. 

Update Equipment 
Maintenance Party 

Allows you to update the Equipment Maintenance Party. 

Delete Equipment Allows a user to deactivate an Umler record, sending the record to archive. 
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Add Equipment 
The Add Equipment function is used to add new equipment to Umler. This function works well 
for adding multiple equipment with identical element values. For adding multiple equipment with 
significant differences or similar to an existing equipment, the Clone Equipment function can 
save time.  

 
Add Equipment is used for new equipment only. Equipment with a Prior ID requires 
the equipment be restenciled. See Single Restencil or Multiple Restencil for details. 

  
Use the following procedure to add equipment: 

 
1. From the main menu, select Maintenance > Add/Change/Delete > Add Equipment. The 

Add Equipment page is displayed (Exhibit 79). 

Exhibit 79. Add Equipment 

 

2. Enter the Equipment ID to be assigned for this unit. Each road or private mark may have 
numbering standards in place. The Equipment ID must follow normal conventions of 2-4 
alpha characters and 1-6 numeric characters. For example, BNSF123456. Multiple IDs can be 
entered at the same time, either on separate lines or separated by commas or a single space. 
Sequential IDs can be entered as a range (BNSF222201-10). 

3. Select the Equipment Group from the drop-down list. When adding multiple equipment 
IDs, only one equipment group is used. Some types cannot be changed after entering the new 
records (e.g., LOCO). If in doubt, add equipment units one at a time. Additionally, the clone 
function can be used for identical or similar units. 

Exhibit 80. Equipment Group 
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4. For articulated equipment, indicate the number of articulations in the Connected Unit Count 
field (up to 99). Otherwise, accept the default value of zero. 

5. (Optional) Select Validate to have Umler validate the request. Otherwise continue. 

6. Select Submit. The system checks to make sure the Equipment IDs entered are not already in 
Umler (active or inactive). 

a. If an active ID exists, the add is not allowed. An error message is displayed. 

b. If an inactive ID is found, an information message suggests using Add-Back to reactivate 
the ID. See Add-Back Equipment. 

c. If the requested IDs are valid, the Add Equipment element entry page is displayed. 
 

Exhibit 81. Add Equipment Example 

 

Elements shown in the table are based upon the Equipment Type selection made. Mandatory 
elements have the red dot in the Flag field ( ). See Exhibit 7 for other flag icons. 

Page navigation and display characteristics are similar to Display Unit. 

7. Complete the fields in the entry page table: 

a. Tab between fields. 

b. For element field help, select the ID link for the field. See Field Help. 

c. Ensure all mandatory fields have been completed. 
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8. When all input is complete, select Validate. The system validates entries against railroad 
business rules and acceptable values and displays an error message under the page title and 
displays any element-specific error message in the error column beside the element. 

9. Correct the errors: 

a. Read through all errors. Because many elements are related, correcting a single element 
might correct multiple errors. 

b. Any error regarding Umler rights (equipment, pool, inspection, or view confidential data) 
or SSO company-specific rights (authorization to act for a company) must be addressed 
first. See the Company SSO and/or Umler Administrator. 

c. Some conditional elements become mandatory based on inputs (rather than Equipment 
Type), so complete all new mandatory fields. 

d. Use field help to change invalid values. Select the ID link for the field. See Field Help. 

e. (Recommended) Correct one error at a time and select Validate between corrections. 

10. Select Validate a final time to ensure errors have been corrected. 

a. If errors are still found (or new errors initiated), make necessary corrections and 
revalidate. 

 

If validation fails after several attempts at correction and revalidation, select 
Suspend to name and save the work until error corrections can be clearly identified. 
The Suspend Work page is displayed (Exhibit 82). See Suspended Work on how to 
resume the Add Equipment task. 

 
Exhibit 82. Suspend Work 

 

• Write a description that makes it easy to locate the suspended task to resume 
work. For example, “Add Equipment” might mean one of several add tasks, so 
the Equipment ID would be helpful. 

• Select Suspend to suspend the task. 
 

b. If no errors are found, a successful validation message is displayed under the page title. 
Continue with the next step. 
 

11. When no errors are found, select Submit. The Equipment updates submitted to the system - 
Success page is displayed (Exhibit 83). 
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Exhibit 83. Equipment Updates Successfully Submitted to the System 

 

12. Select Done to close or select another Umler application menu item (refer to Exhibit 5). 
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Clone Equipment 
The Clone Equipment function is used to add single and multiple equipment by cloning from an 
existing unit.  

Use the following procedure to clone equipment: 

1. From the main menu, select Maintenance > Add/Change/Delete > Clone Equipment. The 
Clone Equipment page is displayed (Exhibit 84). 

Exhibit 84. Clone Equipment 

 

2. Enter a source equipment ID. A cloned equipment source can be from any owner/road. 

• Choose a known matching equipment ID from your road’s rolling stock or a known other 
road’s similar equipment, or 

• Perform a search for a unit with the same characteristics, using Equipment Query. Check 
the Equipment ID search result, open the drop-down list at the right, select Clone 
Equipment and select OK to open the Clone Equipment page with the selected record as 
the source for cloning. 

3. Enter the new Equipment IDs to be created from the source. Each road or private mark may 
have numbering standards in place. The Equipment ID must follow normal conventions of 2-
4 alpha characters and 1-6 numeric characters. For example, BNSF123456. Multiple IDs can 
be entered at the same time, either on separate lines or separated by commas or a single 
space. Sequential IDs can be entered as a range (BNSF222201-10). 

4.  (Optional) Select Validate to have Umler validate the request. Otherwise continue. 

5. Select Submit. The system checks to make sure the Source ID and New Equipment IDs 
entered are not already in Umler (active or inactive). 

a. If an active ID exists, the cloning is not allowed. An error message is displayed. 

b. If an inactive ID is found, an information message suggests using Add-Back to reactivate 
the ID. See Add-Back Equipment. 
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c. If the requested IDs are valid, the Clone Equipment element entry page is displayed 
(Exhibit 85). 

Exhibit 85. Clone Equipment Example 

 

Elements shown in the table are based upon the Equipment Type selection made. Mandatory 
elements have the red dot in the Flag field ( ). See Exhibit 7 for other flag icons. 

Page navigation and display characteristics are similar to Display Unit. 

 
Certain mandatory fields do not port over to the cloned records and new entries are 
required. 

 
6. Complete the fields in the entry page table: 

a. Tab between fields. 

b. For element field help, select the ID link for the field. See Field Help. 

c. Ensure all mandatory fields have been completed. 
 

7. When all input is done, select Validate. The system validates entries against railroad business 
rules and acceptable values and displays an error message under the page title and displays 
any element-specific error message in the error column beside the element. 
 

8. Correct errors and revalidate as described in Add Equipment Step 9. 
 

9. (Optional) Suspend the clone task for later completion as described in the Note. 

10. Select Submit to clone the new equipment units. The Equipment updates are submitted to the 
system and the success message is displayed (similar to Exhibit 83). 
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Add-Back Equipment 
The Add-Back Equipment function is used to reactivate “archived” single and multiple equipment 
units one at a time. If you want to add-back a range of multiple units at once, use the Add-Back 
Multiple Equipment function.  

Use the following procedure to add-back equipment: 

1. From the main menu, select Maintenance > Add/Change/Delete > Add-Back Equipment. 
The Add-Back Equipment page is displayed (Exhibit 86). 

Exhibit 86. Add-Back Equipment 

 
2. Enter one or more fields to search in deletion history. Optionally restrict the search with a 

date range for the deletion period. Refer to Exhibit 22 and Exhibit 25 for field descriptions. 

3. Select Search. Matching records are displayed on the Add-Back Equipment page (Exhibit 
87). 
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Exhibit 87. Add-Back Equipment Search Results 

 

4. Select the Equipment ID link to further process the record. The Add-Back Equipment page 
entry table is displayed (similar to Exhibit 83). 

Elements shown in the table are based upon the Equipment Type of the old equipment.  

Page navigation and display characteristics are similar to Display Unit. 

 
Certain mandatory fields (notably Owner) do not carry over to the Add-Back 
records. New inputs are required. 

 
5. Select Submit. Complete the fields in the entry page table: 

 
a. Tab between fields. 

b. For element field help, select the ID link for the field. See Field Help. 

c. Ensure all mandatory fields have been completed. 
 

6. When all input is complete, select Validate. The system validates entries against railroad 
business rules and acceptable values. If errors are found, an error message appears under the 
page title and any element-specific error messages are displayed in the error column beside 
the element. 

7. Correct errors and revalidate as described in Add Equipment Step 9. 

8. (Optional) Suspend the Add-Back task for later completion as described in the Note. 

9. Select Submit to Add-Back the equipment units. The Equipment updates submitted to the 
system Success page is displayed (similar to Exhibit 83). 
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Add-Back Multiple Equipment 
The Multiple Equipment Add-Back function is used to reactivate multiple “archived” equipment 
units at one time.  

 

If equipment has been added and deleted several times, then the Add-Back Multiple 
Equipment function cannot be used. Instead, the equipment must be added one at a 
time via the regular Add-Back Equipment function.  

 
Use the following procedure to add-back multiple equipment: 
 
1. From the main menu, select Maintenance > Add/Change/Delete > Multiple Add-Back. 

The Multiple Equipment Add-Back page is displayed (Exhibit 88). 

Exhibit 88. Multiple Equipment Add-Back 

 

2. Enter one or more input fields to search in deletion history. Optionally restrict the search with 
a date range for the deletion period. Refer to Exhibit 22 and Exhibit 25 for field descriptions. 

3. Select Search. Matching records are displayed on the Multiple Equipment Add-Back page 
(Exhibit 89). 
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Exhibit 89. Multiple Equipment Add-Back Results 

 

4. Select one or more of the listed equipment IDs. 

5. Select Submit to Add-Back the equipment units. The Equipment updates submitted to the 
system Success page is displayed (similar to Exhibit 83). 
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Modify Single Equipment 
The Modify Single Equipment function is used to change a single equipment unit.  

 

Equipment units that are in conflict require solution of all conflicts when making 
changes. Making changes to one element can cause conflicts in another related 
element. Read through all errors, as they can be related to a single input field. 
Unresolved conflicts can result in Umler enforcing AAR business rules against the 
equipment. Refer to the Umler Data Specifications Manual for acceptable values for 
fields and assistance in resolving conflicts, as well as descriptions of conflict-related 
business rules. 

 
Use the following procedure to modify a single equipment unit: 
 
1. From the main menu, select Maintenance > Add/Change/Delete > Modify Single 

Equipment. The Modify Single Equipment page is displayed (Exhibit 90). 

Exhibit 90. Single Equipment Modify 

 

2. Enter the Equipment ID of the equipment to be modified. 

3. The Single Equipment Modify - Components by Element View is selected by default, but you 
can select the View Components by Location radio button. Component and Location 
diagrams and descriptions are provided in the Umler Data Specifications Manual (accessed 
from the upper right Help link). 

4. Select Modify. The Single Equipment Modify page is displayed with the selected view 
(Exhibit 91). 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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Exhibit 91. Single Equipment Modify - Components by Element View 

 

5. Select or enter values in the New Value fields that require changing. 

For a description of each element, select the ID link in the ID column. See Field Help for 
details. 

 
If viewing components in location view, or if the Switch View button is selected, some 
additional fields are available (Exhibit 92). 

Q. If the equipment Built Date is changed, will the EIN change? 

A. If equipment is added as Pre-registered and the Equipment Add Date is within the 18 
months of the Built Date, any change to the Built Date within the same calendar month/year 
should not cause the EIN to change. A new EIN is generated when the Built Date change is 
greater than 18 months of the Equipment Add Date (Element B082). 
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Exhibit 92. Single Equipment Modify - Components By Location View 

 

In Exhibit 92, the Truck System shows one component in the box at the right, and existing values 
are shown in the four fields under LOCATION_F. 

a. To add another Truck, increment the 1 in the box to 2, and select Go. A new Location 
with open fields is provided (Exhibit 93). 
 

Exhibit 93. After Adding Second Truck Component 

 

It is LOCATION_A and has the same elements as LOCATION _F, but no values. 

b. Add the new values as appropriate. 

6. When all input is complete, select Validate. The system validates entries against railroad 
business rules and acceptable values. If errors are found, an error message appears under the 
page title and any element-specific error messages are displayed in the error column beside 
the element. 

7. Correct errors and revalidate as described in Add Equipment Step 9. 

8. (Optional) Suspend the modify task for later completion as described in the Note. 
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9. Select Submit to modify equipment unit. The Equipment updates submitted to the system 
Success page is displayed (similar to Exhibit 83). 
 

Modify Multiple Equipment 
The Modify Multiple Equipment function is used to change records for multiple equipment units in 
a single edit session.  

 

Equipment units that are in conflict require solution of all conflicts when making 
changes. Making changes to one element can cause conflicts in another related 
element. Read through all the errors, as they can be related to a single input field. 
Refer to the Umler Data Specifications Manual for acceptable values for fields and 
assistance in resolving conflicts. Refer to the Modify Single Equipment Note.  

 
Use the following procedure to modify multiple equipment units: 
 
1. From the main menu, select Maintenance > Add/Change/Delete > Modify Multiple 

Equipment. The Modify Multiple Equipment Units page is displayed (Exhibit 94). 
 

Exhibit 94. Modify Multiple Equipment Units 

 

2. Enter the Equipment ID(s) to be modified. Equipment IDs may already be populated if this 
page was accessed with selections from a query (Exhibit 31). 

 
3. Select Submit. The Modify Multiple Equipment Units (select elements) page is displayed 

(Exhibit 95). 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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Exhibit 95. Modify Multiple Equipment Units – Select Elements 

 

4. Highlight the elements to be modified in the Available Elements window (hold Ctrl key to 
make multiple selections). 

5. Select the right arrow ( ) to move the elements to the right Selected Elements window. In 
Exhibit 95, three elements are selected. To remove elements, highlight the unwanted element 
in the right Selected Elements window and select the left arrow ( ). Use the up & down 
arrows at the right to change the order in which the selected elements are to be displayed. 

6. Select Submit. The Modify Multiple Equipment Units page is redisplayed with chosen 
elements, existing values, and an input field for the new value (Exhibit 96). 

Exhibit 96. Modify Multiple Equipment Units – Update Elements 

 

7. For each Equipment ID, the current value is on the right in each element column. Enter the 
new values of the elements to be changed in the fields provided. 

a. To return to the previous page to select other elements, select Element Selection. 

b. Use the copy icon ( ) to copy a new typed value into all fields for that element column. 

8. Select Submit. The system automatically validates the new entries against business rules and 
errors are displayed above the requested changes by Equipment ID. Resolve errors as 
described in Add Equipment Step 9. 

 

If validation fails after several attempts at correction and revalidation, select 
Suspend to save the work until error corrections can be clearly identified. The 
Suspend Work page is displayed (Exhibit 82). See Suspended Work to resume the 
Modify Equipment task. 
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9. When all conflicts or errors have been corrected, select Submit again. 

Exhibit 97. Equipment Updates Successfully Submitted  

 

10. Select Done to return to the Umler Home/Welcome page. 
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Single Restencil 
When a car is restenciled (generally for a change in ownership), the losing road must grant View 
Confidential Data Rights for the Umler record to the gaining road, and the gaining road must 
accept the rights, and assign to a user (or put into a profile for multiple users) before it can 
perform the Umler restencil task. See Grant Access Rights. Only active or inactive equipment can 
be restenciled (cannot be in pre-registered status). When equipment that is restenciled is made 
active, open EHMS alerts are copied to the new equipment record. 

Use the following procedure to restencil an equipment unit: 

1. From the main menu, select Maintenance > Add/Change/Delete > Single Restencil. The 
Restencil Equipment page is displayed (Exhibit 98). 

Exhibit 98. Restencil Single Equipment 

 

2. Enter the Source Equipment ID (old ID). 

3. Enter the Target Equipment ID (new ID). 

4. Select radio button for Source and target have identical equipment groups: 

a. If Yes is selected (default), continue with submission. 

b. If No is selected, a drop-down text box is displayed: 

 

c. Use the drop-down list to select the new Equipment Group (refer to Exhibit 80). 

5. Select Submit. The Restencil Equipment page with the record for the new Equipment ID 
displayed (Exhibit 99). Many of the existing fields cannot be automatically transferred to the 
new record (e.g., Maintenance Party, Owner, etc.). 
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Exhibit 99. Restencil Equipment Update Record 

 

6. Scroll through the entire record and add values in mandatory fields that did not copy over 
with the record. In the first screen of Exhibit 99, the Owner mandatory field requires a new 
value. Additionally, the Maintenance Party field was changed to reflect the new owner. 

7. When all mandatory fields are input, select Submit. Validation occurs as described in Add 
Equipment. Resolve errors as described in Add Equipment Step 9. 

 
If validation fails after several attempts at correction and revalidation, select 
Suspend to save the work until error corrections can be clearly identified. The 
Suspend Work page is displayed (Exhibit 82). See Suspended Work on to resume the 
Modify Equipment task.  

 
If validation succeeds, the Equipment Updates Submitted to the System page is displayed 
(similar to Exhibit 97). It shows the old Equipment ID being made inactive. 

8. Select OK to return to the Umler Home/Welcome page. 
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Multiple Restencil 
When a car is restenciled (generally for a change in ownership), the losing road must grant View 
Confidential Data Rights for the Umler record to the gaining road, and the gaining road must 
accept the rights, and assign to a user (or put into a profile for multiple users) before it can 
perform the Umler restencil task. See Grant Access Rights. Only active or inactive equipment can 
be restenciled (cannot be in pre-registered status). When equipment that is restenciled is made 
active, open EHMS alerts are copied to the new equipment record. 
 
Use the following procedure to restencil multiple equipment units: 

1. From the main menu, select Maintenance > Add/Change/Delete > Multiple Restencil. The 
Restencil Multiple Equipment page is displayed (Exhibit 100). 

Exhibit 100. Restencil Multiple Equipment 

 

2. Enter the Source Equipment ID(s) (old IDs). 

3. Enter the Target Equipment ID(s) (new IDs): 

a. If the No radio button is selected (default), enter all Target IDs in the order desired. 

b. If the Yes radio button is selected (so numeric gaps present in the Source Equipment IDs 
are preserved with the Target IDs), provide only the starting Target ID. Umler calculates 
the remaining IDs, preserving the gaps. 

4. Select Submit. The Restencil Multiple Equipment page is redisplayed with common 
elements for the type of car (Exhibit 101). 
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Exhibit 101. Restencil Multiple Equipment Update Record 

 
5. In Exhibit 101, the Owner field needed to be changed to RAIL. Optionally, an Effective 

Date of 06/01/2023 was added. 

Other elements might need to be changed as well. The status of restenciled multiple cars is 
Pre-Registered, which should be changed as appropriate via Modify, or via Query. 

 
6. Select Submit. If validation succeeds, the Equipment Updates Submitted to the System page 

is displayed (similar to Exhibit 97). 

7. Select OK to return to the Multiple Restencil page. 

Change Equipment Group 
The Change Equipment Group function allows a user to change an Umler Equipment Group for a 
single equipment unit. Examples are a flat car is having a box installed and is being rebuilt as a 
box car, or a V-Flat is having an auto rack removed/installed. 

Use the following procedure to change an equipment ID’s equipment group: 

1. From the main menu, select Maintenance > Add/Change/Delete > Change Equipment 
Group. The Change Equipment Group page is displayed (Exhibit 102). 

Exhibit 102. Change Equipment Group 

 
2. Enter the Equipment ID. If Change Equipment Group action is selected from a query, 

Equipment ID is populated with the selected Equipment ID. 
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3. Select Submit. The Change Equipment Group page is redisplayed with two new fields 
(Exhibit 103). This also occurs if Validate is selected first. 

Exhibit 103. Change Equipment Group  

 

The existing Equipment Group is shown at the right (BOXC). 

The Target Equipment Group drop-down list only contains eligible groups for change. In 
Exhibit 103, FLAT has been selected. 

4. Select the new Equipment Group from the drop-down list and select Submit. The Change 
Equipment Group (Modify Equipment task) page is displayed (Exhibit 104). 

Exhibit 104. Change Equipment Group - Modify Equipment Task 

 

5. Modify fields as required. Refer to Modify Single Equipment for instructions. All mandatory 
fields must be completed. 
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6. (Optional, but highly recommended) Select Validate. Any errors generated by the Equipment 
Group change will be highlighted in red at the right of the display. Refer to Add Equipment 
Step 9 for addressing error correction. 

 

If validation fails after several attempts at correction and revalidation, select 
Suspend to save the work until error corrections can be clearly identified. The 
Suspend Work page is displayed (Exhibit 82). See Suspended Work to resume the 
Modify Equipment task. 

 
7. When all errors have been corrected, select Submit. The Equipment updates submitted to the 

system page is displayed (Exhibit 105). 
 

Exhibit 105. Equipment Updates Successfully Submitted 

 

8. If conflicts or errors exist, a Notice ID link is provided so you can resolve any remaining 
issues. 

9. Select OK to return to the Umler Home/Welcome page. 

10. (Optional) To verify Umler has accepted the equipment group change, query the Equipment 
number (Exhibit 106). 
 

Exhibit 106. Equipment Query Results - Verify Change Equipment Group 

 
11.  (Optional) If needed, view the Transaction Log to see a list of all fields actually changed for 

the equipment. See Transaction Log. 
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Update Equipment Maintenance Party 
This function allows you to update the Equipment Maintenance Party which identifies the 
responsible maintenance party for the equipment unit. This field can be populated with the owner, 
the lessee, or a third party. If the field is blank, the car owner is the default responsible 
maintenance party. 

Use the following procedure to update the Maintenance Party for equipment IDs: 

1. From the main menu, select Maintenance > Add/Change/Delete > Update Equipment 
Maintenance Party. The Update Equipment Maintenance Party page is displayed (Exhibit 
107). 
 

Exhibit 107. Update Equipment Maintenance Party 

 

2. Enter the Equipment ID(s). If Update Equipment Maintenance Party action is selected from a 
query, this field is populated with the selected Equipment IDs. 

3. Enter the appropriate mark for the new maintenance party. 

4. Select Submit. The Data Submitted to the System page is displayed (similar to Exhibit 83). 

5. Select OK. You are returned to the previous page. 

6. (Optional) Verify the maintenance party update by querying the equipment IDs. 



Umler® Maintenance | Add/Change/Delete     
  

 
   

 
  

Revised January 2024 91 Umler Version 6.0 

Delete Equipment 
Equipment is never actually deleted, but the record becomes inactive. Equipment deletions can be 
reversed using the Add-Back Equipment task. See Add-Back Equipment. The Delete Equipment 
function allows a user to deactivate an Umler record, sending the record to archive.  
 
Use the following procedure to delete a record: 
 
1. From the main menu, select Maintenance > Add/Change/Delete > Delete Equipment. The 

Delete Equipment page is displayed (Exhibit 108). 

Exhibit 108. Delete Equipment 

 

2. Enter in the Equipment ID(s). If Delete Equipment action is selected from a query, this field 
is populated with the selected Equipment IDs. 

3. Select Submit. The Confirm Deletion of equipment page is displayed (Exhibit 109). 

Exhibit 109. Confirm Deletion of Equipment 
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4. For each equipment ID listed: 

a. Check the boxes beside the records. 

b. Select an appropriate Delete Reason from the drop-down for the first ID. Valid values are 
shown in Exhibit 110. 

Exhibit 110. Delete Reasons 

 

c. If the reason for the deletions is the same for all equipment IDs listed, select the down 
arrow icon ( ) to the right of the drop-down, to populate the remaining fields with the 
same delete reason. 

5. When all IDs to be deleted have reasons, select Submit. The Delete Confirmation panel 
provides one last chance to not delete the equipment IDs. 

Exhibit 111. Delete Confirmation  

 

6. To delete, select OK. The Delete Equipment Summary page is displayed (Exhibit 112). 

Exhibit 112. Delete Equipment Summary 

 

7. To exit this page, select Done or another Umler menu item. 
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Car Management 
Exhibit 113. Car Management Submenu 

 

Exhibit 114 describes the options on the Car Management submenu. 

Exhibit 114. Car Management Submenu Items and Descriptions 

Menu Item Description 

Create Pool Header Allows a user to create a new Pool header (for a new Pool ID). 

Delete Pool Header Allows a user to delete a Pool header. 

Remove Lessee Allows a user to remove a lessee from Equipment IDs. 

Report Car Grade 
Inspection 

Allows a user to report car grade inspections. 

Update Equipment 
Management Codes 

Allows a user to change selected elements for several equipment units in one 
editing session. 

Update Pool 
Assignments 

Allows a user to update pool assignments for one or multiple pools. 
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Create Pool Header 
Before equipment can be assigned to a pool, a pool header must be established. The pool header 
identifies the pool ID, the type of pool (commodity, agent, shipper, contaminated, or national), a 
descriptive name for the pool, pool location information, and the pool operator(s) if applicable.  
After a Pool Header is established, equipment may be assigned (added) to the pool.  

Use the following procedure to create a pool header: 

1. From the main menu, select Maintenance > Car Management > Create Pool Header. The 
create Pool Header page is displayed (Exhibit 115). 

Exhibit 115. Create Pool Header 

 
2. Complete *mandatory and optional fields. See Exhibit 116. 
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Field Descriptions for the top of the page are shown below:  

Exhibit 116. Pool Header Fields 

Field Description 

*Pool ID Type a valid seven-digit pool ID. Positions 1 through 3 are the pool 
operator’s AAR Accounting Code (or Rule 260 Code), positions 4 through 
7 are pool IDs assigned by the pool operator. Input the specific Pool IDs or 
search with a range or a wildcard. See Exhibit 23 for more information. 

Note: All unassigned equipment uses pool ID = 0000000. 
*Description General description of the pool (20 characters max). 
Extended Description More detailed description of the pool (80 characters max). 
Reporter Assigned alphabetic reporting mark of the carrier reporting for non-

mechanized operators that have made such an agreement with the reporting 
road (4 characters max). 

*Loading Location The actual shipper loading point or plant location or railroad holding point.  
Must be a valid SPLC location (19 characters max). Use the search icon  
( ) to open the Station Lookup page (Exhibit 39). 

*State/Province 
(Loading) 

Indicates the state or province where the pool is located. This is 
automatically populated with Station Lookup results. 

Held-Short Location Actual location where equipment is held-short if not able to be placed at 
the loading location.  Must be a valid SPLC location (19 characters max). 
Use the search icon ( ) to open the Station Lookup page (Exhibit 39). 

State/Province 
(Held-Short) 

Indicates the State/Province where the equipment is held-short. This is 
automatically populated with Station Lookup results. 

*Operator 1 Assigned alphabetic reporting mark of the actual operator of a specific pool 
(4 characters max). 

Operators 2, 3 and 4 Four-position Marks indicating the actual operators of a specific pool.  
Used in the case of Joint Pools to indicate the parties participating in the 
pool. 

*Pool Maintenance Code 0 = Not Applicable 
1 = Auto/truck loading multi-level flat cars 
2 = Specially equipped chain tie-down cars 
3 = Equipped with cross bar interior restraining devices 
4 = Automobile parts and bulkhead equipped equipment 
5 = Automobile and truck frame equipment 
6 = Flat cars equipped for saddleback loading 
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Field Description 

*Pool Type Used to identify a type of railroad pool assignment: 

C = Equipment assigned to a specific shipper at a specific location 
G = Contaminated cars 
J = Equipment assigned to an agent 
N = Similar to the C Pool, except, the equipment is not assigned to a 

specific shipper or loading point (National Pools). 
O = Equipment assigned to Recall pools 
P = Pool comprised of equipment assigned to accommodate a specific 

commodity. 
T = Pool comprised of equipment assigned to an agent.  

 
3. (Optional) Choose the Future radio button to delay the pool addition to a future date. The 

page expands with an On Future Date field. Refer to Update Pool Header Step 3. 

4. When all fields have been completed, select one of the options described in Exhibit 50. 

When the pool header has been successfully created, it can be populated with equipment using a 
query results action, modifying an Equipment ID, or using Update Pool Assignments. 
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Delete Pool Header 
This function allows a user to delete a pool header. Only pools without assigned equipment can 
be deleted. Deleting a Pool Header can be done from a menu choice, or a car management Pool 
View query results action. 

Use the following procedure to delete a pool header: 

1. From the main menu, select Maintenance > Car Management > Delete Pool Header. The 
Delete Pool Header page is displayed (Exhibit 117). 

Exhibit 117. Delete Pool Header 

 

2. Enter the Pool ID(s) to be deleted. If the Delete Pool action was selected from a query, the 
Pool ID(s) field is populated with selected Pool IDs. 

3. (Optional) Choose the Future radio button to delay the deletion to a future date. The page 
expands with an On Future Date field. Refer to Update Pool Header Step 3. 

4. Select Submit to delete the pool header or select one of the other processing options (similar 
to Exhibit 50). 
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Remove Lessee 
Remove a Lessee function allows railroads to remove themselves from the lessee field of foreign 
equipment. Removing the lessee can result in the equipment’s removal from its current pool 
assignment (if any). In turn, removal of the equipment from a pool may result in new equipment 
management codes being applied. 

Removing a Lessee can be done from a menu choice, query results action, or while modifying an 
Equipment ID. 

Use the following procedure to remove a lessee: 

1. From the main menu, select Maintenance > Car Management > Remove Lessee. The Enter 
Equipment IDs for Lessee Removal page is displayed (Exhibit 118). 

Exhibit 118. Enter Equipment IDs for Lessee Removal 

 

2. Enter the Equipment ID(s) to have Lessee removed. If the Remove Lessee action was 
selected from a query, the Equipment ID(s) field is populated with selected Equipment IDs. 

3. Select one of the processing options (similar to Exhibit 50). 

Report Car Grade Inspection 
When Maintenance > Car Management > Report Car Grade Inspection is selected from the 
menu, the Car Grade Inspection page is displayed (Exhibit 141). This can also be access using the 
Inspection menu item. See Car Grade Inspection for instructions. 

Update Equipment Management Codes 
There are five basic types of codes used in the Equipment Management Code structure: user 
defined routing, system generated, pool control, mechanical restriction and mechanical restriction 
reason. This section explains how to determine existing equipment management codes and how to 
update these codes. The system also uses the Legacy UMLER transportation codes and 
transportation condition codes. 
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Exhibit 119. Equipment Management Codes 
CODE DESCRIPTION 

MD Mechanical designation 
UR User defined routing (Exhibit 123)  
SG System generated 
PC Pool control 
MR Mechanical restriction (Exhibit 124)  

MRR Mechanical restriction reason (Exhibit 125)  
TC Umler transportation code 

TCC Umler transportation condition code 
 
Use the following procedure to change equipment management codes: 

1. From the main menu, select Maintenance > Car Management > Update Equipment 
Management Codes. The Update Car Management Codes page is displayed (Exhibit 120). 

2. Although entering Equipment IDs and requesting changes can be made directly on this page, 
you might want to begin from an equipment query, or if existing codes need to be viewed 
first, from a Car Management query (equipment view). Either query allows you to select the 
Update Equipment Management Codes action for selected Equipment IDs. The Car 
Management Query path is shown is this instruction. 
 

Exhibit 120. Update Equipment Management Codes 

 



Umler® Maintenance | Car Management     
  

 
    

 
  

Revised January 2024 100 Umler Version 6.0 

3. From the main menu, select Query > Car Management Query. The Pool/Equipment Search 
page is displayed (Exhibit 37). Execute the query for the appropriate equipment as described 
in Equipment View. The Pool/Equipment Search Results page is displayed (Exhibit 121). 
 

Exhibit 121. Pool/Equipment Search Results - Equipment View 

 
The red box shows the Equipment Management Codes. The UR, MR, and MRR values can be 
modified. 

4. Check the boxes beside the Equipment IDs to be modified in the exact same way. 

5. Select Update Equipment Management Codes in the action drop-down and select OK. The 
Update Equipment Management Codes page is displayed, prepopulated with selected 
Equipment IDs (Exhibit 122). 

Exhibit 122. Update Equipment Management Codes  
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6. Make updates to the fields: 

a. User Defined Routing Instruction. Valid values include:  
Exhibit 123. User Defined Routing (UR) 

 

b. Mechanical Restriction. Valid values include: 

Exhibit 124. Mechanical Restriction (MR) 

 

c. Mechanical Restriction Reason. Valid values include: 

Exhibit 125. Mechanical Restriction Reason (MRR) 

 

7. When all values are selected, select Submit. The Data Submitted to the System page is 
displayed (similar to Exhibit 83). 

8. If errors are generated, correct and select Submit. 
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9. Select OK to exit the page. 

10. (Optional) Verify the Equipment Maintenance Code changes have been updated. If returned 
to the Pool/Equipment Search Results page, select the Search Criteria tab and reselect 
Search. The results page is redisplayed with changes made (Exhibit 126). 

Exhibit 126. Pool/Equipment Search Results Showing Updated Codes 

 

The TC and TCC values were automatically updated by MR and MRR updates. 

 
Only the Railinc Administrator can remove a Mechanical Restriction = S and a 
Mechanical Restriction Reason = X from a piece of equipment.  

 
11. Select a Umler menu item to exit this page. 
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Update Pool Assignments 
The Update Pool Assignment function allows users to add equipment to Pool IDs. 

Updating a Pool Assignment can be done from the menu choice, query results action, or while 
modifying an Equipment ID. 

Use the following procedure to update pool assignments: 

1. From the main menu, select Maintenance > Car Management > Update Pool 
Assignments. The Pool Assignment page is displayed (Exhibit 127). 

Exhibit 127. Pool Assignment  

 

This page has two sections. The top allows you to assign multiple equipment IDs into one pool. 
The bottom allows you to place various individual equipment IDs into respective pools. You must 
know the pool numbers before beginning. There is no search function on this page—Use a Car 
Management Query (Pool View) to search. See Pool View. 

2. Select the appropriate radio button for the desired assignment. Continue with: 

• Assign Equipment to One Pool 

• Assign Equipment to Individual Pools 

Assign Equipment to One Pool 
3. Enter the Equipment ID(s). See Exhibit 23 for acceptable formats for entering multiple IDs. 

4. Tab and enter the appropriate single Pool ID. 
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5. (Optional) Select the Future button to delay the assignment, if appropriate. See Exhibit 49. 

6. Select one of the processing options (similar to Exhibit 50). 

Assign Equipment to Individual Pools 
3. Enter the first equipment ID in the Equipment ID(s) field. 

4. Tab and enter the appropriate Pool ID for that equipment. 

5. Repeat for each piece of equipment (up to 10 equipment units for this page). 

6. (Optional) Select the Future button to delay the assignment, if appropriate. See Exhibit 49. 

7. Select one of the processing options (similar to Exhibit 50). 

Adding From a Query 
If Add to Pool action is requested for selected equipment on the Equipment Query Results page, 
the Pool Assignment page is displayed prepopulated with selected Equipment IDs (Exhibit 128). 

Exhibit 128. Pool Assignment From a Query 

 
1. Tab and enter the appropriate single Pool ID. 

2. (Optional) Select the Future button to delay the assignment, if appropriate. See Exhibit 49. 

3. Select one of the processing options (similar to Exhibit 50). 
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Removing from a Query 
If Remove from Pool action is requested for selected equipment on the Equipment Query Results 
page, the Confirm Pool Unassignment page is displayed prepopulated with selected Equipment 
IDs (Exhibit 129). 

Exhibit 129. Confirm Pool Unassignment 

 

1.  (Optional) Check Future to delay the unassignment, if appropriate. See Exhibit 49. 

2. Select one of the processing options (similar to Exhibit 50). 
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Inspections 
The Maintenance Inspections function is used to record inspection and service data for 
equipment. 

 Use the following procedure to record inspections and services: 

1. From the main menu, select Maintenance > Inspections. The Inspections page is displayed 
(Exhibit 130). 

Exhibit 130. Inspections 
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2. Select the link for the inspection or service to be recorded. The corresponding page for that 

inspection is displayed. Because many of the inspection pages are similar, only one 
description is provided for each unique interface, as shown in Exhibit 131. 

Exhibit 131. Inspection/Service Processing 

Inspection/Service Processing Flow Reference 
AFMC Inspection AMFC Inspection 
Air Brake Test 
Autorack Certification 
Autorack Repair 
Door Lube Inspection 
Reflectorization Event 
Vehicular Flat Car Certification 

Air Brake Test 

Autorack Inspection Autorack Inspection 
Car Grade Inspection When all required fields are entered, select one of 

the options from Exhibit 133. 
Car Grade Inspection 

Locomotive Air Brake Inspection L1, L2 and L3 
Locomotive Air Car Inspection 
Locomotive Annual Inspection 

When all required fields are entered, select one of 
the options from Exhibit 133. 

Locomotive Air Brake L1 Inspection 
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Inspection/Service Processing Flow Reference 
Locomotive Cab Signals Inspection 
Locomotive Event Recorder Inspection 
Locomotive Hand Brake Inspection 
Locomotive Out of Service 
Locomotive Periodic Inspection 
Locomotive RCL Inspection 
QMI Daily Inspection 
Locomotive Inspection Due Date Update When all required fields are entered, select one of 

the options from Exhibit 133. 
Locomotive Inspection Due Date Update 

Locomotive Storage Event Locomotive Storage Event 
 
Selecting equipment, highlighting an inspection action from the query results page drop-down 
(Exhibit 31) and selecting Apply navigates directly to the corresponding inspection pages 
described in the following sections. 
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AMFC Inspection 
When the AMFC Inspection link is selected, the AMFC Inspection page is displayed (Exhibit 
132). 

Exhibit 132. AMFC Inspection 

 

1. Enter the *Equipment ID(s) for which an inspection is to be recorded. Equipment IDs may 
already be populated if this page was accessed with selections from a query (Exhibit 31). 

2. Complete the required fields (in bold *red with asterisk): 

Field Description 
*Inspection Reporter Select the 4-character Mark from the drop-down list for the person or 

organization reporting the inspection. 
*Inspection Performer Enter the 3 to 4-character Mark for the person/shop who performed the 

inspection. 
*Inspection Conducted by Enter the name of person/shop who conducted the inspection. 
*Inspection Certified by Enter the name of person/shop who certified the inspection. 
*Location/SPLC Use the search icon ( ) to select the SPLC where the inspection was 

performed (Exhibit 135). 
*Inspection Date Done Use the calendar picker ( ) to select the date the inspection was 

performed. 
 

3. When all required fields are entered, select one of the inspection processing options: 

Exhibit 133. Inspection Processing Options 
Validate Validates data before submission to facilitate error correction.  
Submit Send the data to the system. Validation occurs first, so error correction can be done. 

If successful, a message similar to Exhibit 139 is displayed.  
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Suspend Saves the inspection input for completion later. Opens the Suspend Work page 
(similar to Exhibit 82). See Suspended Work to resume the inspection task. 

Clear Clears any entries, resetting to a blank form. 
Cancel Cancels the entry and returns to the Inspections page. 

 
4. Select Done to return to the Inspections page (Exhibit 130). 

Air Brake Test 
When the Air Brake Test link is selected, the Air Brake Test page is displayed (Exhibit 134). 
The same interface is used for Autorack Certification, Autorack Repair, Door Lube Inspection, 
Reflectorization Event, and Vehicular Flat Car Certification. Check the page title to verify it 
reflects the appropriate inspection/service. 

Exhibit 134. Air Brake Test 

 

5. Enter the *Equipment ID(s) for which an inspection is to be recorded. This field may 
already be populated if this page was accessed with selections from a query (Exhibit 31). 

6. Complete the required fields (in bold *red with asterisk): 

Field Description 
*Inspection Reporter Select the 4-character Mark from the drop-down list for the person or 

organization reporting the inspection. 
*Inspection Performer Enter the 3 to 4-character Mark for the person/shop who performed the 

inspection. 
*Inspection Date Done Use the calendar picker ( ) to select the date the inspection was performed. 
*Location/SPLC Use the search icon ( ) to select the SPLC where the inspection was 

performed (Exhibit 135). 
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*Air Brake Test Device Select either A-Automatic or M-Manual.  
 
 

Exhibit 135. SPLC Lookup 

 
a. Enter criteria for SPLC Lookup and select Search. The SPLC Lookup Results page is 

displayed (Exhibit 136). 

Exhibit 136. SPLC Lookup Results 

 
b. Select the radio button beside the correct location and choose Select. The results are used 

to populate the Location field. First row entry might appear as shown in Exhibit 137. 
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Exhibit 137. Air Brake Test  

 
7. As needed to populate entries in rows below with the same value: Use the down arrow ( ) to 

repeat the entry for all successive fields. In Exhibit 138, some columns were repeated using 
the down arrow icon. 

Exhibit 138. Air Brake Test With Repeated Columns 
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8. When all required fields are entered, select one of the options from Exhibit 133. 

Exhibit 139. Air Brake Test Results Submitted 

 

9. Select Done to return to the Inspections page (Exhibit 130). 
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Autorack Inspection 
When the Autorack Inspection link is selected, the Autorack Inspection page is displayed 
(Exhibit 140). 

Exhibit 140. Autorack Inspection 

 

1. Complete the first five fields as described in Air Brake Test Steps 5 and 6. 

2. Enter the Autorack Inspector ID. 

3. Complete the remaining nine fields using the drop-down list on the right to select the 
appropriate rating. 

4. When all required fields are entered, select one of the options from Exhibit 133. 
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Car Grade Inspection 
When the Car Grade Inspection link is selected, the Car Grade Inspection page is displayed 
(Exhibit 141). 

Exhibit 141. Car Grade Inspection 

 

1. Enter the 3- to 4-character Inspecting Mark (or use drop-down list to select from those roads 
the logged in user is authorized to represent). 

2. For each graded equipment (10 max this page) enter: 

Field Description 
*Equipment ID(s) Enter the Equipment ID for which a car grade inspection is to be recorded. 

This can be automatically populated as described in Air Brake Test Step 5. 
Only one Equipment ID per field. The page expands beyond ten fields if 
automatically populated. 

*Car Grade Select the car grade specified by the Inspector from the Car Grade drop-down 
list. 

*Date Use the calendar picker ( ) to select the date the inspection was performed. 
*Location/SPLC Use the search icon ( ) to select the SPLC where the car grade inspection 

was performed (Exhibit 135). 
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For more information about car grades, see the current Field Manual of the AAR Interchange 
Rules, which can be obtained from MxV Rail at 719-584-0750 (ask for Publications) or at 
https://aarpublications.com/. 

3. When all required fields are entered, select one of the options from Exhibit 133. 

https://aarpublications.com/
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Locomotive Air Brake L1 Inspection 
When the Locomotive Air Brake L1 Inspection link is selected, the Locomotive Air Brake L1 
Inspection page is displayed (Exhibit 142). Currently, this same interface is used for Locomotive 
Air Brake (L1, L2 and L3) Inspection, Locomotive Annual Inspection, Locomotive Cab Signals 
Inspection, Locomotive Quarterly Inspection, and Locomotive RCL Inspection. Verify that the 
page title reflects the appropriate inspection/service. 

 
Exhibit 142. Locomotive Air Brake L1 Inspection 

 

1. Complete the first five fields as described in Air Brake Test Steps 5 and 6. 

2. Use the calendar picker ( ) to select the date the next locomotive inspection is scheduled. 

3. (As needed for same entries) Use the down arrow icon ( ) to repeat the entry for all 
successive fields. 

4. When all required fields are entered, select one of the options from Exhibit 133. 
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Locomotive Inspection Due Date Update 
You must be authorized to update a locomotive inspection due date. See Add Inspection Right. 

When the Locomotive Inspection Due Date Update link is selected, the Update Locomotive 
Inspection Due Dates page is displayed (Exhibit 143). 

Exhibit 143. Update Locomotive Inspection Due Dates 

 

Four different inspection type updates can be submitted. 

1. Enter the equipment IDs for which a specific update is needed. Equipment IDs may already 
be populated if this page was accessed with selections from a query (Exhibit 31). 

2. From the drop-down list, select the locomotive inspection to be updated. Exhibit 143 shows 
one selected. 

3. Use the calendar picker ( ) to select the date the next Scheduled and Inspection Due Dates. 

4. When all required fields are entered, select one of the options from Exhibit 133. 
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Locomotive Storage Event 
You must be authorized to update a locomotive inspection due date. See Add Inspection Right. 
 
The FRA Drop Dead Date is the date a locomotive would not be allowed to be on the road due to 
an expired inspection date. Locomotives not needed for moving trains are sometimes removed 
from the road for a period of non-use. When a locomotive is in storage, its FRA Drop Dead Date 
is extended for the period of storage (or to a specified new FRA Drop Dead Date). 

When the Locomotive Storage Event link is selected, the Report Locomotive Storage Event page 
is displayed (Exhibit 144). 
 

Exhibit 144. Report Locomotive Storage Event 

 

1. Enter the Equipment ID(s) for which a storage event is to be reported. Refer to the 
Equipment ID(s) description. Equipment IDs may already be populated if this page was 
accessed with selections from a query (Exhibit 31). 

2. Select the appropriate radio button: 

• Number of Days in Storage 
• New FRA Drop Dead Date 

3. Enter Storage Data: 

• For Number of days in storage, type a numeric entry (e.g., 90). 
• Use the calendar picker ( ) to select the New FRA Drop Dead Date. 

4. When all required fields are entered, select one of the options from Exhibit 133. 
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Company-Specific Equipment Groups 
Company-Specific Equipment groups are private pools of equipment that are only available to the 
company specified. Umler allows you to assign and remove equipment from company-specific 
equipment groups. 

Exhibit 145. Company-Specific Equipment Groups Submenu 

 

Exhibit 146 describes the options on the Company-Specific Equipment Groups submenu. 

Exhibit 146. Company-Specific Equipment Groups Items and Descriptions 

Menu Item Description 

Search Group Allows a user to search for and view Company-Specific Equipment groups.  

Create Group Allows a user to create a new Company-Specific Equipment group. 

Add Equipment to 
Group 

Allows a user to add equipment to a Company-Specific Equipment group.  

Remove Equipment 
from Group 

Allows a user to remove equipment from a Company-Specific Equipment 
group. 

Move Equipment 
Between Groups 

Allows a user to move equipment between Company-Specific Equipment 
groups.   
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Search Group 
The Search Group function allows users to search for company-specific equipment groups based 
on company-specific equipment group attributes, equipment attributes, and/or equipment 
ownership/control attributes.  

 
The system displays only those company-specific equipment groups created by your 
company.  

 
Use the following procedure to search for company-specific equipment groups: 

1. From the main menu, select Maintenance > Company-Specific Equipment Groups > 
Search Group. The Search for Company-Specific Equipment Groups (Basic) page is 
displayed (Exhibit 147). 
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Exhibit 147. Basic Search for Company-Specific Equipment Groups 

 

2. Complete search criteria as needed. Refer to Exhibit 148 for field descriptions. *Red fields 
are mandatory. 
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Exhibit 148. Company-Specific Equipment Groups Field Descriptions 

Field Description 

*View Select group view or equipment view. 
• In Group View, if no search criteria is entered, Umler displays all 

company-specific equipment groups created by your company. Best 
choice for deleting or editing a group. 

• In Equipment View, you must specify at least one search parameter. 
Group ID(s) Identification number assigned to an equipment group (alphanumeric, with 

no spaces). Must be unique. 
Group Name Name given to an equipment group. 
Group Description Description given to an equipment group. 
Equipment ID(s) Enter the specific equipment IDs (e.g., ABCD123) or search with a range 

(e.g., ABCD123-999) or a wildcard. See Exhibit 23 for more information. 
Equipment Type Codes Enter the complete code (e.g., M500) in the single blank input field. 
Equipment Group(s) Used to indicate the general equipment group being sought. Multiple-

selection text box. See Equipment Group(s) in Exhibit 22. 
Mechanical 
Designation(s) 

Alphabetic AAR code assigned to the physical description of the unit. See 
the Umler Data Specifications Manual. 

Creator User ID System User ID used when Group was created. 
Last Updated User ID System User ID used when Group was last updated. 
Equipment Initial(s) The initials stenciled on the specified equipment. 
Umler Owner The Umler owners of the specified equipment. 
Umler Company The Umler company that owns the specified equipment. 
Lessee The company leasing the specified equipment. 
Stenciled Mark Owner The stenciled mark owners for the specified equipment. 

 
3. (Optional) Select the Group Fields tab. The Search for Company-Specific Equipment 

Groups (Group Fields) page is displayed (Exhibit 149). 

a. Each field can contain up to 80 characters. 

b. Typical use might include specific commodities for the group (e.g., Paper Rolls for a 
certain group of boxcars). Searches can be done using these special fields; however, 
matches must be exact, including the field letter (i.e., something entered in field A must 
be searched for in field A). 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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Exhibit 149. Group Fields Search for Company-Specific Equipment Groups 

 

4. In the *Output to: drop-down list, select Browser to have the search results displayed in the 
browser (default). Otherwise, select CSV (comma separated values).  

5. Select *Maximum Number of Results: (Browser Output Only) from the drop-down list for 
the maximum number of result records to be returned (100, 500, 1000—default is 1000). 

6. Select a processing option: 
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Exhibit 150. Search for Company-Specific Equipment Groups Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. The Company-

Specific Equipment Group Search Results screen is displayed  
(Exhibit 151 for Group View or Exhibit 157 for equipment view). 

Count Executes the search and outputs a single line message with the count of records meeting the 
specified criteria. Similar to Exhibit 34. 

Clear Clears any entries, resetting to a blank form. 
 

Exhibit 151. Group View Company-Specific Equipment Groups Search Results 

 

7. Select the check boxes beside the Equipment Group IDs to be processed. 

8. Choose from the following options: 

a. Deleting a Group 

b. Viewing/Editing a Group 

c. Viewing Creator or Last Updated User IDs 

d. Select the Search Criteria tab to run another search. 
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Deleting a Group 
To delete a group, select the check box beside the group ID and select Apply in the action drop-
down. The Confirm Delete of Company-Specific Equipment Group(s) page is displayed (Exhibit 
152). 

Exhibit 152. Confirm Delete of Company-Specific Equipment Group(s) 

 

To confirm the delete, select Submit. A data submission page is displayed (not shown). Select 
Done. The Company-Specific Equipment Groups link page is displayed (Exhibit 153). 

Exhibit 153. Company-Specific Equipment Groups Links 

 

Select the appropriate link or select an item from the main menu. 

Viewing/Editing a Group 
While on the Company-Specific Equipment Groups Search Results (Group View) page (Exhibit 
151), select the Group ID link. The View Company-Specific Equipment Group page is displayed 
(Exhibit 154). 
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Exhibit 154. View Company-Specific Equipment Group 

 
 

When finished viewing, select Done to return to the search results. 
 

• To view user contact information, select the User ID links and refer to Viewing Creator 
or Last Updated User IDs. 

• To edit the Group, select Edit. The Edit Company-Specific Equipment Group page is 
displayed (Exhibit 155). 
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Exhibit 155. Edit Company-Specific Equipment Group 

 
Edit fields as required and select Submit. A data submission page is displayed (not shown). 
Select Done. The Company-Specific Equipment Groups link page is displayed (Exhibit 153). 
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Viewing Creator or Last Updated User IDs 
When a User ID link is selected on a page, the User Contact Info page for that person is displayed 
(Exhibit 156). 

Exhibit 156. User Contact Info 

 

To send the person an email, select the email link. Otherwise, select Done to return to previous 
page. 

Exhibit 157. Equipment View Company-Specific Equipment Groups Search Results 

 

Select the check boxes beside the Equipment IDs to be processed, choose either the Add or 
Remove action drop-down option, and select OK. Refer to: 

• Add Equipment to Group or 

• Remove Equipment from Group  
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Create Group 
 Use the following procedure to create a new Company-Specific Equipment Group: 

1. From the main menu, select Maintenance > Company-Specific Equipment Groups > 
Create Group. The Create Company-Specific Equipment Group page is displayed (Exhibit 
158). 

Exhibit 158. Create Company-Specific Equipment Group 
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2. Enter the two required fields (refer to Exhibit 148). 

3. (Optional) Enter Group fields as described in Search Group Step 3. 

4. Select Submit to create the group. A data submission page is displayed (not shown). Select 
Done. The Company-Specific Equipment Groups link page is displayed (Exhibit 153). 

5. No equipment is in the new group. Choose the Add Equipment to Company-Specific 
Equipment Group link and refer to Add Equipment to Group. 
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Add Equipment to Group 
Equipment cannot be added to a group from a regular Equipment Query. The query must be from 
Company-Specific Equipment Groups Search Results (Equipment View) page (Exhibit 157). 
 
Use the following procedure to add equipment to a Company-Specific Equipment Group: 

1. From the main menu, select Maintenance > Company-Specific Equipment Groups > Add 
Equipment to Group. The Add Equipment to Company-Specific Equipment Groups page is 
displayed (Exhibit 159). 

Exhibit 159. Add Equipment to Company-Specific Equipment Groups 

 

2. Enter the Equipment ID(s). If coming from a Group search results equipment view, the 
Equipment ID(s) field is populated with selected Equipment IDs. 

3. Up to four Group ID equipment additions can be processed at one time on this page. Enter the 
known Group ID, or use the search icon ( ) to search for a Group ID. The Company-
Specific Equipment Group Lookup page is displayed (Exhibit 160). 
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Exhibit 160. Company-Specific Equipment Group Lookup 

 

a. Enter criteria to locate the appropriate Group. Group fields are not available on the 
lookup page. Refer to Exhibit 148 for field descriptions. 

b. Select Search. The Company-Specific Equipment Group Lookup Search Results page is 
displayed. 
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Exhibit 161. Company-Specific Equipment Group Lookup Search Results 

 

c. Select the radio button beside the appropriate Group ID and select OK. The Add 
Equipment to Company-Specific Equipment Groups page is redisplayed with the selected 
group (Exhibit 162). 

Exhibit 162. Add Equipment to Company-Specific Equipment Groups Example 

 

4. Select Submit to add the equipment. A data submission page is displayed (not shown). Select 
Done. The Company-Specific Equipment Groups link page is displayed (Exhibit 153). 
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Remove Equipment from Group 
Equipment cannot be removed from a group from a regular Equipment Query. The query must be 
from Company-Specific Equipment Groups Search Results (Equipment View) page (Exhibit 
157). 
 
 Use the following procedure to remove equipment from a Company-Specific Equipment Group: 

1. From the main menu, select Maintenance > Company-Specific Equipment Groups > 
Remove Equipment from Group. The Remove Equipment from Company-Specific 
Equipment Groups page is displayed (Exhibit 163). 

Exhibit 163. Remove Equipment from Company-Specific Equipment Groups 

 

2. Enter the Equipment ID(s). If coming from a Group search results (equipment view), the 
Equipment IDs are shown in the Confirm Removal of Equipment from Company-Specific 
Equipment Groups page is displayed (Exhibit 164). 

3. Select Next. The Confirm Removal of Equipment from Company-Specific Equipment 
Groups page is displayed (Exhibit 164). 

Exhibit 164. Confirm Removal of Equipment from Company-Specific Equipment Groups 

 

4. Select the checkbox beside each Equipment ID to be removed. 
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5. Select Submit. A data submission page is displayed (not shown). Select Done. The 
Company-Specific Equipment Groups link page is displayed (Exhibit 153). 

Move Equipment Between Groups 
Use the following procedure to move equipment from one Company-Specific Equipment Group 
to another: 

1. From the main menu, select Maintenance > Company-Specific Equipment Groups > 
Move Equipment between Groups. The Move Equipment to Another Company-Specific 
Equipment Group page is displayed (Exhibit 165). 

Exhibit 165. Move Equipment to Another Company-Specific Equipment Group 

 

2. Enter the Equipment ID(s) to be moved. 

 
Because the move option is not available in the action drop-down list in the 
Equipment view search results, you can choose to “Add” selected IDs and view the 
entire set of IDs in the Add Equipment to Company-Specific Equipment Groups 
page (Exhibit 159). The Equipment IDs field can be copied by placing the cursor in 
the box and pressing Ctrl+A to select them all and pressing Ctrl+C to copy all. 
Then without executing any Add function, choose the Move Equipment between 
Groups menu item, and paste (Ctrl+V) the copied Equipment IDs into the 
Equipment ID field on the Move page.  

 
3. From Group ID: Enter the current Group ID or use the search icon ( ) to search for a 

Group ID. Refer to Add Equipment to Group Step 3 for instructions. 
 

4. To Group ID: Enter the new Group ID or use the search icon ( ) to search for a Group ID. 
Refer to Add Equipment to Group Step 3 for instructions. 

5. Select Submit. A data submission page is displayed (not shown). Select Done. The 
Company-Specific Equipment Groups link page is displayed (Exhibit 153). 
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Notice Management 
The Notice Management function allows you to process informational, warning, and error notices 
via the Umler web interface.  Each company’s administrator defines how the Umler should 
inform your company (e.g., tickler preferences).  Regardless of those preferences, you can 
manage the notices within Umler.  Umler allows you to search for notices based on detailed 
search criteria, view notice details, fix errors related to notices, and suppress read, resolved, or 
unwanted notices. 

Use the following procedure to manage notices: 

1. From the main menu, select Maintenance > Notice Management. The Search Notices page 
is displayed (Exhibit 166). 

Exhibit 166. Search Notices – Top Mandatory Fields 

 

2. Enter search criteria as appropriate. Red fields are mandatory. Field Descriptions for the top 
of the page are shown in Exhibit 167. 
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Exhibit 167. Search Notices Field Descriptions – Top   

Field Description 

*Starting 
Date/Time 

Use the calendar picker ( ) to select the dates to be queried. 

Note: Default Date/Time is two days starting at midnight the previous day and 
ending today at 11:59 PM. 

Enter a 2-digit hour (01–12), and minutes (00–59), and select the AM or PM 
radio button in the Time field. 
 
Note: Select the Search All Dates check box in order to search all dates. 

Equipment ID(s)  Enter the specific equipment IDs (e.g., ABCD123) or search with a range (e.g., 
ABCD123-999) or a wildcard. See Exhibit 23 for more information. 

Company-Specific 
Equipment 
Group(s) 

Enter the current Group ID or use the search icon ( ) to search for a Group ID. 
Refer to Add Equipment to Group Step 3 for instructions. 

*Notice Type Select the Notice Type. Multiple selections are allowed. The default is ALL. 
*Notice Level Select the Notice Level of Error, Information, and Warning. Multiple selection is 

allowed. The default is ALL. 

• Error—notices which have failed to pass business rules. Because of these 
errors, the related transactions have failed to update the Umler database. The 
system creates an error notice when a pool or equipment transaction is 
submitted that violates the business or security rules. 

• Information—notices which inform user of system processes. For example, 
an information notice is created to inform user of the completion of a bulk 
upload. The system creates informational notices for company-specific 
events. 

• Warning—warning notices created by the system to warn about company-
specific events. For example, the system will warn a company prior to 
deleting one of its idle pool headers. 

*Notice Status Select the Notice Status of Active (default), Deleted, or Both. 

Note: Notices are not deleted, rather their status is just changed to “deleted”. 
When the issue mentioned in the notice has been successfully resolved 
the status changes to “deleted”. 

*Notice Group Select the Notice Group of Normal (default), Future Effective, or Conflict. 

Note: Unresolved conflicts can result in Umler enforcing AAR business rules 
against the equipment. Refer to the Umler Data Specifications Manual for 
information about these rules and conflict resolution. 

 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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Exhibit 168. Search Notices – Bottom Optional Fields 

 

3. (Optional) Enter the search criteria as appropriate. Field Descriptions for the bottom of the 
page are shown in Exhibit 169. 
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Exhibit 169. Search Notices Field Descriptions – Bottom 

Field Description 

Event/Response 
Code(s) 

Enter a known Event/Response Code or use the search icon ( ) to search 
for a code. The Element ID Lookup page is displayed. 

Note: Use a find (Ctrl+F) within the lookup page to locate the needed 
error. 

Exhibit 170. Event/Response Codes 

 
Check the boxes beside the appropriate descriptions and select Done. The 
Search Notices page is redisplayed with the selected codes. 

Equipment Type Code Alphanumeric code (one alpha and three numeric) used to designate a 
specific type of equipment and attributes. 

Equipment Group Used to indicate the general equipment group being sought. See Equipment 
Group(s) in Exhibit 22. 

Pool ID(s) Search for notices related to the specified pool ID(s). 
Mechanical 
Designation(s) 

Search for notices related to equipment with the specified mechanical 
designation(s). 

Notice ID(s) Search for notices with specific notice ID(s). This can be from online 
notices, or emails. 

User ID(s) Search for notices related to actions taken by a specified user ID(s). 
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Field Description 

Element ID(s) Enter a known Element ID or use the search icon ( ) to search for an ID. 
The Element ID Lookup page is displayed. 

Note: Use a find (Ctrl+F) within the lookup page to locate the needed 
element. 

Exhibit 171. Element ID Lookup Using Find 

 
Check the boxes beside the needed element IDs and select OK. The Search 
Notices page is redisplayed with the selected IDs. 

Restrict results to only 
Element ID(s) 

Use this check box to restrict the results to only Element IDs. 

Equipment Initial(s) The initials stenciled on the specified equipment. 
Umler Owner The Umler owners of the specified equipment. 
Umler Company The Umler Company that owns the specified equipment. 
Lessee The company leasing the specified equipment. 
Stenciled Owner Mark The stenciled mark owners for the specified equipment. 

 
4. In the *Output to: drop-down list, select Browser to have the search results displayed in the 

browser (default). Otherwise, select CSV (comma separated values).  

5. (For browser only) Set the *Maximum Number of Results: field to the maximum number of 
result records to be returned (100, 500, 1000). Default is 1000. 

6. Select one of the processing options shown in Exhibit 172. 

Exhibit 172. Search Notices Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See Online 

Notice Search Results or CVS Notice Search Results. 
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Count Executes the search and outputs a single line message with the count of records 
meeting the specified criteria. See Exhibit 34. 

Clear Clears any entries, resetting to a blank form. 
 

Online Notice Search Results 
If you have chosen to view search results online, the Notice Search Results page is displayed 
(Exhibit 173).  

When notices are deleted or restored, the page does not reflect those changes unless refreshed (by 
executing the search again). To search again, select the Search Criteria tab and select Search. 

Exhibit 173. Online Notice Search Results 

 
Options on this page include: 

View Notice Details—Select the ID link. See Exhibit 174. 

View User Information—Scroll to the right and select the User ID link. See Exhibit 156. 

From the action drop-down list at the top right of the table: 

Delete Selected—Check the boxes beside Active notices to be deleted (to change status to 
inactive), select Delete Selected (default) from the drop-down list, and select Apply. Delete 
can also be done while viewing notice details (see Exhibit 174 and Exhibit 175). 

Historical Lineage—Check the box beside notices of equipment with an EIN history, select 
Historical Lineage from the drop-down list, and select Apply. 

Modify Equipment—Check the box beside one of the notices to be modified, select 
Modify Equipment from the drop-down list, and select Apply. 

Restore Selected—Check the boxes beside Deleted notices to be restored (to change status 
to Active), select Restore in the drop-down list, and select Apply. Restore can also be done 
while viewing notice details (see Exhibit 174 and Exhibit 175). 
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View Notice Details 
When the Notice ID link on the Notice Search Results page (Exhibit 173) is selected, the Notice 
Details page is displayed (Exhibit 174). 

Exhibit 174. Notice Details With Active Error 

 
In this notice, the new data entered did not meet business rules (reason written in red at right). 
The pool number is from CSXT (begins with 712), but the Pool Operator 1 is entered as BNSF. 
Either the Pool ID is incorrect or the Pool Operator 1. 

With the proper authorization and the corrections known, the corrected input can be entered 
directly on this page in the new data column, validated and submitted. 

To view User ID information, select the User ID link. See Exhibit 156. 

Use the Previous and Next buttons at the upper right to view details of the previous or next 
notice from the Notice Search Results list. 
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Processing options include: 

Exhibit 175. Notice Processing Options 
Validate Validates data before submission to facilitate error correction. Fixing one error can 

produce another when business rules are applied. 
Submit Send the data to the system. Validation occurs first, so error correction can be done. 

If successful a message similar to Exhibit 139 is displayed.  
Delete or 
Restore 

Toggles the status of the notice. If the notice is active, only the Delete button 
appears. If the status is deleted, only the Restore button appears.  

Done Returns to the Search Results page (Exhibit 173). 
 

CVS Notice Search Results 
If you have chosen to view/save CSV search results, the search results are displayed in MS Excel 
(Exhibit 176). 

Exhibit 176. CSV Notice Search Results in Excel 

 

If you chose to open the file rather than save it (refer to Exhibit 31), you have the option to save it 
as an Excel file while viewing. Exhibit 177 contains information for reading CSV notice records.  

• The information for each notice spans multiple lines. 

• A notice always begins with a summary line. 

• The summary line is followed by zero or more element lines.  (If the notice involves 
specific elements of a unit, the notice contains an element line for each such element). 
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• The notice concludes with zero or more message lines.  (If the notice includes messages 
that are not specific to any particular element, the notice contains a message record for 
each such message). 

• Each notice occupies a minimum of two lines (SUMMARY and MESSAGE, or 
SUMMARY and ELEMENT, or all three). 

• There are no labels on the exported Excel file headings. 
 

Exhibit 177. CSV Notice Search Results CSV File Column Key 
Column Attribute Name Definition 

  SUMMARY Lines 
A Notice ID The unique identifier for this notice. 
B Summary Record 

Indicator 
A summary record indicates the beginning of the data for the next 
notice in the file.  The value is always SUMMARY. 

C Timestamp The date and time at which the system generated this notice. 
D Equipment ID The equipment ID for the equipment (if any) related to this notice. 
E Equipment Group The equipment group for the equipment (if any) related to this notice. 
F Equipment Type 

Code 
The equipment type code for the equipment (if any) related to this 
notice. 

G Mechanical 
Designation 

The mechanical designation for the equipment (if any) related to this 
notice. 

H Pool ID The pool ID for the pool (if any) related to this notice. 
I Type The type of notice. 
J Event Code The event code for this notice. 
K Level The level for this notice. 
L User ID The User ID (if any) that originated the transaction resulting in this 

notice. 
M Status The status for this notice. 
N Maintenance 

Party Mark 
The mark of the maintenance party. 
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Column Attribute Name Definition 
  MESSAGE Lines 

A Notice ID The unique identifier for this notice. 
B Record Indicator Indicates the beginning of the message data for the Notice ID record.  

The value is MESSAGE. 
C Message The text of the message. 
  ELEMENT Lines 

A Notice ID The unique identifier for this notice. 
B Record Indicator Indicates the beginning of the data for elements in the Notice ID 

record.  The value is always ELEMENT. 
C Element ID The identifier for the type of element. 
D Pre-transaction 

Data 
The value of this element before the transaction that produced this 
notice. 

E Transaction Data The value of this element specified by the transaction that produced 
this notice. 

F Current Data The current value of this element. 
G Message 1 A message (e.g., an error message) regarding this element. 
H Message 2* A message (e.g., an error message) regarding this element. 
  . . . 

Etc. Message N* A message (e.g., an error message) regarding this element. 
* Each element record contains one or more messages. 
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Suspended Work 
Many Umler Add, Modify, and update functions provide a processing option to Suspend the 
work. You may need to verify data or may not be able to resolve validation issues without 
guidance. When Suspend is chosen the Suspend Work page is displayed (Exhibit 82). Enter 
enough information to make the task easily recognizable for resuming the task. 

When a user is ready to resume suspended work: 

1. From the main menu, select Maintenance > Suspended Work. The Suspended Work page is 
displayed (Exhibit 178). 

Exhibit 178. Suspended Work 

 

Default order is by oldest timestamp. To recall a recently suspended task, sort by Timestamp to 
bring the newest to the top of the display. Actions for this page include: 

• Resume Suspended Work 

• Delete Suspended Work 
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Resume Suspended Work 
2. Check the box beside the task to be resumed and select Resume. The appropriate Umler page 

is displayed with a Transaction Retrieved message (Exhibit 179). 

Exhibit 179. Update Pool Header Transaction Retrieved 

 

3. Complete the page in accordance with instructions for that task (For Exhibit 179, this would 
be the Update Pool Header task). 
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Delete Suspended Work 
If a decision is made to delete an incomplete task: 

2. Check the box beside the task to be resumed and select Delete. The Confirm Delete 
Suspended Tasks page is displayed (Exhibit 180). 

Exhibit 180. Confirm Delete Suspended Tasks 

 

3. To delete the tasks, select Delete. Otherwise, select Cancel. The Suspended Work page is 
redisplayed, and the deleted tasks are no longer in the list. 
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Manage Future Transactions 
The Manage Future Transactions function allows users to search for and delete any future 
effective transactions pertaining to equipment pools.  

Use the following procedure to view future transactions: 

1. From the main menu, select Maintenance > Manage Future Transactions. The Search 
Future Effective Transactions page is displayed (Exhibit 181). 

Exhibit 181. Search Future Effective Transactions 

 
2. Enter the search criteria as appropriate. Red fields are mandatory. Field Descriptions for the 

top of the page are shown in Exhibit 182. 

Exhibit 182. Search Future Effective Transaction Descriptions 

Field Description 

Future Effective 
Transaction ID(s) 

ID assigned to the future transaction (if known). 

Description Description previously entered for the future transaction 
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Field Description 

Starting Future Effective 
Date 

Use the calendar picker ( ) to select the dates to be queried. 
Note: Default Date is today starting at 12:00 AM. 

Ending Future Effective 
Date 

Use the calendar picker ( ) to select the dates to be queried. 
Note: Default Date is 12/31/9999 at 11:59 PM. 

Transaction Type(s) Select from four available choices. 
User ID(s) Search for future transactions entered by specified user ID(s). 
Pool ID(s) Type 7-digit pool IDs to search for future transactions related to those 

pools. 
Equipment ID(s)  Enter the specific equipment IDs (e.g., ABCD123) or search with a range 

(e.g., ABCD123-999) or a wildcard. See Exhibit 23 for more information. 
 

3. In the *Output to: drop-down list, select Browser to have the search results displayed in the 
browser (default). Otherwise, select CSV (comma separated values).  

4. (For browser only) Set the *Maximum Number of Results: field to the maximum number of 
result records to be returned (100, 500, 1000). Default is 1000. 

5. Select one of the processing options shown in Exhibit 183. 

Exhibit 183. Search Future Transaction Processing Options 
Search Executes the search and outputs to the Browser or to CSV as requested. See Exhibit 

184. 
Count Executes the search and outputs a single line message with the count of records 

meeting the specified criteria. See Exhibit 34. 
Clear Clears any entries, resetting to a blank form. 

 
Exhibit 184. Future Effective Transaction Search Results 

 

Actions for future transactions include: 

• To view the future transaction, select the ID link at the left. See Exhibit 185. 

• To delete the transaction, check the box beside the appropriate IDs, select Delete Future 
Effective Transaction from drop-down list (only choice) in the top right, and select 
Apply. A confirmation page is displayed. 
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• To change the date of a future transaction, delete the incorrect transaction, and then create 
a new future transaction with the new date. 

Exhibit 185. Future Effective Transaction Details 

 

When finished viewing the details, select Done to return to the search results. 

To confirm the deletion of a future transaction, select Delete. Otherwise, select Cancel to return 
to the search results. 
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Upload/Download 
Exhibit 186. Upload/Download Menu 

 

Exhibit 187 describes the tasks available on the Upload/Download menu. 

Exhibit 187. Upload/Download Menu Items and Descriptions 

Menu Item Description 

Bulk Upload 
Transactions 

Allows you to upload CSV formatted records, such as pool assignments, 
Equipment Management codes, and car grade inspections. This includes both 
new and corrected records. 

Upload Corrected 
Notices 

Allows you to upload corrections or updates to CSV transactional records 
associated with received notices. This includes CSV-formatted text files. 

Request Umler 3.2 
Refresh 

Allows you to resynchronize the company’s local copy of the Umler pool and 
equipment data following an interruption of messaging or an error occurring at 
the company site for Umler 3.2. The refresh functionality is not intended to 
synchronize a company’s local system with the complete Umler master file. 
The refresh functionality does not replace master data extracts. 

Request Umler 3.1 
Refresh 

Allows you to resynchronize the company’s local copy of the Umler pool and 
equipment data following an interruption of messaging or an error occurring at 
the company site for Umler 3.1. The refresh functionality is not intended to 
synchronize a company’s local system with the complete Umler master file. 
The refresh functionality does not replace master data extracts. 
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Bulk Upload Transactions 
Umler CSV transaction records in the correct format can be uploaded as a batch using the Bulk Upload 
Transactions function. When Upload/Download > Upload Transactions is selected, the Upload Umler 
Transactions page is displayed (Exhibit 188). 

Exhibit 188. Upload Umler Transactions 

 

Follow the online instructions at the top of the page. 

When the upload has completed, the Upload Summary page is displayed (not shown). It contains 
the following information: 

• At the top of the page, the system displays the summary information for the upload 
process. 

• The system displays the total number of transactions processed from the uploaded file. 

• The system displays the number of transactions successfully validated and applied to the 
system. 

• The system displays the number of transactions that failed. A transaction might fail 
during parsing, validation, etc. 

• At the bottom of the page, the system displays the details of any failed transactions. For 
each failure, the system displays the line number of the transaction (in the file) that failed 
and a description of the reason for failure. 

• An email tickler is sent (if so configured—see Configure Ticklers) and the summary is 
stored in notice management. 
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Upload Corrected Notices 
The system allows you to download error notices in CSV format. You can make the necessary 
corrections within the CSV file (see CVS Notice Search Results) and then upload the file to apply 
the corrections to the system. The system only processes notices that include elements. The 
system uses the value in the Transaction Data field of each element record to reprocess the 
transaction. 

When Upload/Download > Upload Corrected Notices is selected, the Upload Corrected Error 
Notices page is displayed (Exhibit 189). 

Exhibit 189. Upload Corrected Error Notices 

 

Follow the online instructions at the top of the page. 

As with the upload just described, the system displays the processing results to you via the web 
interface and generates an informational tickler notice indicating the processing results. 
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Request Umler 3.2 Refresh 
To limit excessive use of system resources (e.g., bandwidth, CPU cycles, etc.), the system 
restricts the amount of refresh data that users can request. The system allows users to specify the 
appropriate refresh data by equipment ID(s), pool ID(s), or date/time range. 

When an authorized Umler 3.2 user selects Upload/Download > Request Umler 3.2 Refresh, 
the Refresh page is displayed (Exhibit 190). 

Exhibit 190. Refresh 

 

Refreshes can be done using Equipment Characteristics, Pool Data, or a Date/Time Range. 

Equipment Characteristics 
1. Select the Equipment Characteristics radio button. 

2. Enter the Equipment IDs to be refreshed. See Exhibit 23 for information on entering 
multiple IDs. 

3. Select Submit to refresh the equipment. 
 
Pool Data 
1. Select the Pool Data radio button. 

2. Enter the Pool IDs to be refreshed. See Exhibit 23 for information on entering multiple IDs. 

3. Select pool options: 

a. Pool Header only—refreshes general information contained in the specified pool headers 

b. Pool Assignments only—refreshes equipment within the specified pools 

c. Both—refreshes both specified pool headers and assignments 

4.  Select Submit to refresh the pool data. 
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Date/Time Range 
1. Select the Date/Time Range radio button. 

2. Set the Starting Date/Time for the refresh: 

a. Use the calendar picker ( ) to select the Starting Date. 

b. Enter a 2-digit hour (01–12), and minutes (00–59). 

c. Select the AM or PM radio button. 

3. Set the Ending Date/Time for the refresh: 

a. Use the calendar picker ( ) to select the Ending Date. 

b. Enter a 2-digit hour (01–12), and minutes (00–59). 

c. Select the AM or PM radio button. 

4. Select Submit to refresh the time range. 

 

Request Umler 3.1 Refresh 
When an authorized Umler 3.1 user selects Upload/Download > Request Umler 3.1 Refresh, 
the Refresh page is displayed (Exhibit 190). 

Refer to Request Umler 3.2 Refresh for instructions—the process is identical. 
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Account Administration 
Exhibit 191. Account Administration 

 
Exhibit 192 describes the tasks available on the Account Administration menu. 

Exhibit 192. Account Administration Menu Items and Descriptions 

Menu Item Description 
Security Management Opens the Security Management page (Exhibit 193). 

Configure Ticklers Allows account administrators to specify which types of event notifications 
should be sent by Umler, and to whom. 

Usage Statistics Allows you to download usage statistics in CSV format. 
 

Security Management 
The security module ensures that only authorized users can access specific equipment and pools, 
report inspections, or perform other procedures within the system. 

The Umler security module supports an administrator’s ability to manage access rights for intra-
company users, manage access rights given to other companies, manage access rights given by 
other companies, and transfer access rights to another company. When managing access rights for 
intra-company users, Umler security allows the administrator to add, edit, delete, and/or clone 
access rights. When managing access rights given to other companies, the Umler security module 
allows the administrator to view existing rights, grant new rights, and/or revoke existing rights.  
When managing access rights given by other companies, the Umler security module allows the 
administrator to assign and/or relinquish those rights to users within his company. This module 
also allows every user to view his access rights. 

Note the distinction between a company, a SCAC, and Equipment Initials. For the purposes of 
this system: 

• Company: can own one or more SCACs (Standard Carrier Alpha Code) 

• SCAC: can own one or more Equipment Initials 

Umler relies on the IRF (Road Mark Register) to define the relationship between SCACs and 
Equipment Initials. 

Access rights are assigned in Umler by the company Umler administrator. Access rights include 
pool-related rights, equipment-related rights, inspection-related rights and view confidential data 
rights. 

For each access right, the administrator must specify the following characteristics: 
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Timeframe of authority—The timeframe of authority defines the period (effective 
date/time to expiration date/time) during which the access right will exist. 

Type of access—The administrator must specify the type of actions to which the access 
right applies: 

Equipment Access Rights—For an equipment-related access right, the administrator 
specifies one or more of the following types of access: 

• Update Equipment Management Codes 
• Non-Owner Self-As-Lessee Removal 
• Equipment - “Add to Pool” 
• Equipment - “Remove from Pool” 
• Update Equipment Maintenance Party 
• Add Equipment 
• Update Equipment 
• Delete Equipment 

Pool Access Rights—For a pool-related access right, the administrator specifies one or 
more of the following types of access: 

• Add Pool Header 
• Update Pool Header 
• Delete Pool Header 
• Pool Assignment / Unassignment 

Inspection Access Rights—For an inspection access right, the administrator specifies 
timeframe, marks, and equipment for which you can report inspections. 

View Confidential Data Access Rights—For inter-company rights only, a view 
confidential data access right, the administrator specifies timeframe, marks, and 
equipment for which you can view confidential data. 

Range of equipment, pools, and inspection rights—For an equipment-related access 
right, the administrator specifies to which pieces of equipment the access right applies. The 
administrator restricts access to any one of the following: 

All Equipment The access right applies to all equipment controlled by the company. 
SCAC(s)   The administrator may specify one or more SCACs (from the set of SCACs 

managed by the administrator) to which the access right applies. 
Equipment Initials The administrator may specify one or more equipment initials (from the set of 

car initials managed by the administrator) to which the access right applies. 
Equipment 
Group(s) 

The administrator may specify one or more equipment groups (e.g., box cars, 
tank cars, locomotives, etc.) to which the access right applies. See Equipment 
Group(s) in Exhibit 22.  

Equipment IDs or 
Equipment Series 

The administrator may specify one or more equipment IDs to which the access 
right applies. 
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Range of pools—For a pool-related access right, the administrator specifies to which pools 
the access right applies. The administrator restricts access to one of the following: 

All pools The access right applies to all pools controlled by the company. 
Pool ID(s) The administrator may specify one or more pool IDs to which the access right 

applies.   
 
When Account Administration > Security Management is selected, the Security Management 
page is displayed (Exhibit 193). 

Exhibit 193. Security Management 

 
There are four security management task sections: 

• Administer Access Rights Internal to My Company 
• Administer Access Rights Involving Other Companies 
• Search User Access Rights 
• Transfer Access Rights Between Companies (Railinc Administrators only) 

 
All access rights activities are listed on the Security Management page. 
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Administer Access Rights Internal to My Company 
The following actions pertain to access rights internal to your company. 

• View My Access Rights (available to all users) 

• Manage Intra-Company User Access Rights (Company Administrators only) 

• Manage Security Profiles (Company Administrators only) 

• Add/Remove User To/From Security Profiles (Company Administrators only) 
 

View My Access Rights 
This security management option is available to all Umler users. On the Security Management 
page (Exhibit 193), select View My Access Rights. The View a User’s Access Rights page is 
displayed (Exhibit 194). 
 

Exhibit 194. View a User’s Access Rights 

 

To view the details of a specific access right, select the radio button beside the access and select 
View. The details of the access are displayed. Exhibit 195 show the access details for the pool 
right access listed in Exhibit 194. 
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Exhibit 195. Pool Access Right – View Only 

 

Select the Company link to view the Company Contact information page (similar to Exhibit 58). 

No other actions are available on this page. When finished viewing, select Done. 

Manage Intra-Company User Access Rights 
A company Umler administrator can update a user’s access rights.  The administrator can grant 
new access rights, modify existing access rights, delete existing access rights, or copy access 
rights from another user. 

 
Before assigning access rights, check the user’s existing rights to ensure rights are 
not duplicated or contradicted. 

 
Use the following procedure to manage user access rights: 
 
1. On the Security Management page (Exhibit 193), select Manage Intra-Company User 

Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 196). 
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Exhibit 196. Update a User’s Access Rights 

 

2. Scroll and select the radio button beside the user to be updated. Then choose Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 197). 

Exhibit 197. Update a User’s Access Rights for Selected User 

 

The following actions are possible: 

• Add Pool Right 
• Add Equipment Right 
• Add Inspection Right 
• Edit 
• Delete 
• Clone Rights from another User 
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ADD POOL RIGHT 
Use this function to add pool rights. When Add Pool Right is selected, the Pool Access Right 
page is displayed for the selected user ID (Exhibit 198). 

Exhibit 198. Pool Access Right for User ID 

 
1. Complete the fields (mandatory fields are in red): 

Exhibit 199. Pool Access Right Field Descriptions 

Field Description 

*Description Enter a description of the access rights. It can be simple, like Pool Rights 
or specific, like BOXC Pools Only, or Hoppers and Gondolas Pool to 
indicate wider scope. 

Timeframe of Authority Specify the *Effective Date and the *Expiration Date for the granted pool 
right. The Effective date defaults to today’s date and must be greater than 
or equal to today’s date. The Expiration Date must be greater than or equal 
to the Effective Date. 
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Field Description 

Range of Pool Select either the All Pools radio button (default) or the Pool ID(s) radio 
button. For Pool ID(s), enter either specific Pool IDs or a range. 

Type of Access Select one or more of the available access types (allowed activities) to 
assign (Press Ctrl key for multiple selections.): 

• Add a Pool Header 
• Update a Pool Header 
• Delete a Pool Header 
• Pool Assignment / Unassignment 

 

2. When all fields are completed, select Save. The Update a User’s Access Rights page is 
redisplayed with the new rights displayed. 
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ADD EQUIPMENT RIGHT 
Use this function to add equipment rights. When Add Equipment Right is selected, the 
Equipment Access Right page is displayed for the selected user ID (Exhibit 200). 

Exhibit 200. Equipment Access Right for User ID 

 

1. Complete the fields (mandatory fields are in *red): 

Exhibit 201. Equipment Access Right Field Descriptions 

Field Description 

*Description Enter a description of the access rights. It can be simple, like Equipment 
Rights or specific, like BOXC Equip, or Hopper and Gondola Equip to 
indicate wider scope. For equipment, it might include SCACs in the 
description. 
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Field Description 

Timeframe of Authority Specify the *Effective Date and the *Expiration Date for the granted 
equipment right. The Effective date defaults to today’s date and must be 
greater than or equal to today’s date. The Expiration Date must be greater 
than or equal to the Effective Date. 

Range of Equipment Select either the All Equipment radio button (default) or: 
• SCAC(s) – Select one or more listed railroad marks. 
• Initial(s) – Select one or more listed equipment initials. 
• Equipment Group(s) – Select one or more listed equipment types. 
• Equipment – Enter specific equipment Marks and numbers 

(Equipment IDs). 
Press Ctrl key for multiple selections. 

Type of Access Select one or more of the available access types (allowed activities) to 
assign (Press Ctrl key for multiple selections.): 

• Non-Owner Self-As-Lessee Removal 
• Equipment - “Add to Pool” 
• Equipment - “Remove from Pool” 
• Add Equipment 
• Modify Equipment 
• Delete Equipment 

 
2. (Optional) Select the Count Equipment button to determine the number of equipment units 

included in the rights assigned. 

Exhibit 202. Count for Access Rights 

 

3. When all fields are completed, select Save. The Update a User’s Access Rights page is 
redisplayed with the new rights displayed. 
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ADD INSPECTION RIGHT 
Use this function to add inspection rights. When Add Inspection Right is selected, the 
Inspection Access Right page is displayed for the selected user ID (Exhibit 203). 

Exhibit 203. Inspection Access Right for User ID 

 

1. Complete the fields (mandatory fields are in *red): 

Exhibit 204. Inspection Access Right Field Descriptions 

Field Description 

*Description Enter the Description of the access rights. It can be simple, like Inspection 
Rights or specific, like BOXC Inspection, or Hopper and Gondola 
Inspection to indicate wider scope.  

Timeframe of Authority Specify the *Effective Date and the *Expiration Date for the granted 
inspection right. The Effective Date defaults to today’s date and must be 
greater than or equal to today’s date. The Expiration Date must be greater 
than or equal to the Effective Date. 
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Field Description 

Authorize reporting as 
the following marks 

Use the All Marks checkbox to (default) select all marks or uncheck this 
box and select individual listings under the Mark(s) heading. Press Ctrl 
key for multiple selections. 

Authorize reporting for 
the following 
inspections 

Use the All Inspections checkbox to select all inspection types (default) or 
uncheck this box and select individual listings under the Inspection Type(s) 
heading (refer to Exhibit 130). Press Ctrl key for multiple selections. 

Range of Equipment Select either the All Equipment radio button (default) or: 
• SCAC(s) – Select one or more listed railroad marks. 
• Initial(s) – Select one or more listed equipment initials. 
• Equipment Group(s) – Select one or more listed equipment types. 
• Equipment – Enter specific equipment Marks and numbers 

(Equipment IDs). 
Press Ctrl key for multiple selections. 

 
2. (Optional) Select the Count Equipment button to determine the number of equipment units 

included in the rights assigned. 

3. When all fields are completed, select Save. The Update a User’s Access Rights page is 
redisplayed with the new rights displayed. 
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EDIT 
Use to edit or view an existing access right.  

Use the following procedure to edit (or view) user access rights: 

1. On the Security Management page (Exhibit 193), select Manage Intra-Company User 
Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 196). 

2. Scroll and select the radio button beside the user to be updated. Then choose Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 197). 

3. Select the radio button beside the access right to be viewed or edited and select Edit. The 
<Pool, Equipment, or Inspection> Access Rights page is displayed accordingly. A statement 
indicates the User ID that is being edited. The page shows the existing settings. 

4. If no changes are needed, select Cancel to return to the Update a User’s Access Rights page, 
otherwise, continue. 

5. Modify the content as described in Update Access Rights as described in Edit (Access rights): 

6. When all changes have been made: 

a. (Optional) Select the Count Equipment button to determine the number of equipment 
units included in the revised rights assigned. See Exhibit 202. 

b. Select Save. The Update a User’s Access Rights page is redisplayed with the revised 
rights displayed. 

DELETE 
Use this option to delete an existing access right.  

Use the following procedure to delete user access rights: 

1. On the Security Management page (Exhibit 193), select Manage Intra-Company User 
Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 196). 

2. Scroll and select the radio button beside the user to be updated. Then choose Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 197). 

3. Select the radio button beside the access right to be deleted and select Delete. The Confirm – 
Delete an Access Right page is displayed (Exhibit 205). 
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Exhibit 205. Confirm - Delete an Access Right 

 

4. If unsure about the deletion select Cancel. Otherwise, select Delete to confirm. The Update a 
User’s Access Rights page is redisplayed without the deleted access right listed. 

CLONE RIGHTS FROM ANOTHER USER 
Use this option to clone access rights from another user.  

Use the following procedure to clone rights: 

1. On the Security Management page (Exhibit 193), select Manage Intra-Company User 
Access Rights. The Update a User’s Access Rights page is displayed (Exhibit 196). 

2. Scroll and select the radio button beside the user to be updated. Then choose Select. The 
Update a User’s Access Rights page is redisplayed with the selected user’s access rights 
(Exhibit 197). 

3. Select Clone Rights from Another User. The Select Access Right Source page is displayed 
(Exhibit 206). 

Exhibit 206. Select Access Right Source 

 
4. Scroll and select the radio button beside the user whose access rights are to be cloned 

(copied). Then select Clone Rights. The Confirm Clone Access Rights page is displayed 
with the selected source user’s access rights (Exhibit 207). 
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Exhibit 207. Confirm Clone Access Rights 

 
5. If unsure about the rights, select Cancel to exit. Otherwise, select Confirm Clone Rights. 

The Update a User’s Access Rights page is redisplayed with the new cloned rights. The 
effective date defaults to the current date. 

Manage Security Profiles 
The manage security profiles option allows a Company Umler Administrator to create security 
profiles for his/her company. A profile represents a collection of access rights. The Company 
Umler Administrator can then associate a profile to multiple users in one step, thus simplifying 
access rights management. 

ABOUT COMBINING POOL AND EQUIPMENT ACCESS RIGHTS 
A company administrator can restrict a user activity to certain pools, equipment groups, 
equipment initials, or equipment units (equipment initial/numbers). 

By combining Pool Rights along with Equipment Rights for a user, the administrator can create 
tighter security around that user’s access rights. For example, the administrator can restrict the 
equipment groups, equipment initials, or equipment units that a pool operator could assign to a 
pool. 

Example 1: 
• User is granted Pool Rights for All Pools. 
• User is also granted Equipment Rights for Gondolas only. 

Result: The user has rights to all pools but can only assign Gondolas to those pools. 

Example 2: 
• BNSF User is granted Pool Right for a single specific Pool Id (NNNNNNN). 
• BNSF User is also granted Equipment Rights for Equipment Initial ATSF. 

Result: The user has rights only to pool NNNNNNN and can only assign Equipment 
Initials of ATSF to that specific pool. 

Use the following procedure to work with security profiles: 

1. On the Security Management page (Exhibit 193), select Manage Security Profiles. The 
Manage Security Profiles page is displayed (Exhibit 208). 
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Exhibit 208. Manage Security Profiles 

 

2. Select from the following options: 

a. Select Add to add a new security profile. See Adding a New Security Profile. 

b. Select the ID hyperlink of a displayed security profile to edit that profile. See Editing a 
Security Profile. 

c. Check the box beside a listed security profile and select Clone to clone an existing 
security profile. The Administrator should select the closest profile to the new one to be 
created. See Cloning a Security Profile. 

d. Check the box beside a listed security profile and select Delete to delete that profile. See 
Deleting a Security Profile. 

ADDING A NEW SECURITY PROFILE 
When Add is selected on the Manage Security Profiles page (Exhibit 208), the Add Security 
Profile page is displayed (Exhibit 209). 

Exhibit 209. Add Security Profile 
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1. Enter the *Security Profile Name. It is suggested that these be role-related and intuitive. For 
example, Inspectors, Manager Full Rights, or Boxcar Pool Manager, etc. 

2. (Optional) Check the boxes for User IDs to be the new security profile users. Assignments 
can be done later during the security profile edit.  

a. If needed, select the User ID link to view contact information for that user. 

b. Select View Individual Access Rights link to view access rights already assigned to that 
user. 

3. Select Save to save the profile name. The Edit Security Profile page is displayed with a 
success message and additional buttons (Exhibit 210). 

4. A new profile has no rights assigned. A profile ID is assigned automatically by Umler. 

 
Exhibit 210. Edit Security Profile for New Profile 

 
5. Add Pool, Equipment, and Inspection rights and select Save as described in: 

• Exhibit 199. Pool Access Right Field Descriptions 

• Exhibit 201. Equipment Access Right Field Descriptions 

• Exhibit 204. Inspection Access Right Field Descriptions 



Umler® Account Administration | Security Management     
     

Revised January 2024 175 Umler Version 6.0 

6. (Optional) Check the boxes beside those User IDs to be the new security profile users. 
Assignments can be done later during subsequent security profile edits. 

7. When all rights and users have been added, select Save and Return to save the created 
security profile and return to the Manage Security Profiles page. The new profile is listed. 
 

EDITING A SECURITY PROFILE 
When a profile User ID link is selected on the Manage Security Profiles page (Exhibit 208), the 
Edit Security Profile page is displayed (Exhibit 211). 
 

Exhibit 211. Edit Security Profile for Existing Profile 

 

Perform one of the following actions: 

Add profile users—Check the boxes beside the User IDs and select Save to remain on the Edit 
Security Profile page or Save and Return to save the profile user additions and return to the 
Manage Security Profiles page. 
Delete profile users—Uncheck the boxes beside the User IDs and select Save to remain on the 
Edit Security Profile page or Save and Return to save the profile user deletions and return to the 
Manage Security Profiles screen. 
Edit existing access rights—Select the View Individual Access Rights link. The <Pool, 
Equipment, or Inspection> Access Rights page is displayed accordingly. Modify and Save the 
content as described in Update Access Rights as described in Edit (Access rights). 
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Add new pool rights, equipment rights, or inspection rights—Select the corresponding 
command button. Enter rights and Save as described in the following: 

• Exhibit 199. Pool Access Right Field Descriptions 

• Exhibit 201. Equipment Access Right Field Descriptions 

• Exhibit 204. Inspection Access Right Field Descriptions 
 

Delete access rights—Check the box beside the Pool, Equipment, or Inspection Rights to be 
removed and select Delete. A confirmation page is displayed with a choice to Cancel or Delete. 
 
CLONING A SECURITY PROFILE 
When you check the box beside the profile ID link on the Manage Security Profiles page (Exhibit 
208) and select Clone, the Edit Security Profile page is displayed (Exhibit 212). 

 
Exhibit 212. Clone a Security Profile 

 
The unnamed new security profile contains exactly the same rights as its source and also has the 
same user population.  

Use the following procedure to complete the cloning process: 

1. Enter the new cloned Security Profile Name. 

2. Unselect All users in the User ID field. 
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3. (Optional) Check the box beside the User IDs that are to be the new security profile users. 
Profile users can also be added later during an edit session. 

4. Update Access Rights as described in Edit (Access rights). 

5. When all users and right have been adjusted, select Save. The Manage Security Profiles page 
is displayed with the new, cloned profile. Umler automatically assigns a Profile ID. 
 

DELETING A SECURITY PROFILE 
When you check the box beside the profile ID link on the Manage Security Profiles page (Exhibit 
208) and select Delete, the Confirm Delete of Security Profile(s) page is displayed (Exhibit 213). 

Exhibit 213. Confirm Delete of Security Profile(s) 

 

If unsure about the deletions, select Cancel. Otherwise, select Delete. The Manage Security 
Profiles page is redisplayed with a success message, and the deleted profiles are not listed. 

Add/Remove User To/From Security Profiles 
This function allows the administrator to add/remove multiple security profiles for a single user. 
If more than one user is involved, it can be quicker to edit the security profiles and assign 
multiple users during the edit session. 

Use the following procedure to add/remove user to/from security profiles: 

1. On the Security Management page (Exhibit 193), select Add/Remove User to/from Security 
Profiles. The Add/Remove User to/from Security Profiles page is displayed (Exhibit 214). 
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Exhibit 214. Add/Remove User To/From Security Profiles 

 

2. Select the radio button beside the User ID to be added or removed as a profile user and 
select. The second Add/Remove User to/from Security Profiles page is displayed (Exhibit 
215). 

Exhibit 215. Add/Remove User To/From Security Profiles Add/Remove Windows 

 

The user being modified is listed below the page title. 

3. Add or remove profiles: 

• To add a profile, select/highlight a profile from the Available Profiles window and select 
the right arrow ( ). The selected profile moves to the Profiles Currently Assigned to this 
User window.  
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• To add all profiles to the user, select the double right arrow ( ). No profile selection is 
necessary. 

• To remove a profile, select/highlight a profile the Profiles Currently Assigned to this 
User window and select the left arrow ( ).  

• To remove all profiles from the user, select the double left arrow ( ). No profile 
selection is necessary. 

4. Select Save to save changes and return to the Security Management page.  A successful 
update message is displayed. 
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Administer Access Rights Involving Other Companies 
An administrator grants access rights—to equipment, inspections, and pools, as well as access to 
confidential data controlled by his/her company (grantor)—to another company (grantee). 

The grantor’s administrator selects a grantee (by company) from the list of Umler-participating 
companies. The administrator updates the grantee’s access rights to the grantor’s data. The 
grantor’s administrator can grant new access rights to the grantee or revoke any of the grantee’s 
existing access rights. 

A “handshake” between companies is required for Inter-Company access rights. A grantee must 
accept a grant before it becomes effective. 

The following actions are for access rights involving other companies and are available only to 
Company Administrators: 

• Manage Inter-Company Right/Profiles Granted by My Company  

• Manage Inter-Company Access Rights Granted to My Company  

• Manage Inter-Company Profiles Granted to My Company  

• Special SSO Security Request for Non-Participating Companies  

• View Status of Special Umler SSO Requests  
 

Manage Inter-Company Right/Profiles Granted by My Company 
This function allows a grantor administrator to grant access rights for equipment, inspections, and 
pools controlled by his/her company as well as access to confidential data.  

Use the following procedure to work with access rights granted to other companies: 

1. On the Security Management page (Exhibit 193), select Manage Inter-Company 
Right/Profiles Granted by My Company. The Inter-Company Right/Profiles Granted by 
My Company page is displayed (Exhibit 216). 

Exhibit 216. Inter-Company Access Rights Granted by My Company 
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This page shows existing rights by Company. If a new company is to be added, select the radio 
button beside the Add a company drop-down list. The list becomes active (Exhibit 217). Locate 
the company and select. The list closes with the selection showing. 

Exhibit 217. Add a Company 

 

2. Otherwise, select the radio button beside the existing company listed whose access is to be 
added to or revised. 

3. Choose one of the following options: 

Grant Access Rights—Opens the Update Access Rights page for the selected company 
(Exhibit 218). 

Grant Profiles—Opens the Manage Security Profiles page for the selected company  
(Exhibit 221). 

GRANT ACCESS RIGHTS 
When the administrator selects a grantee and selects Grant Access Rights on the Inter-Company 
Right/Profiles Granted by My Company page, the Update Access Rights page is displayed. 

Exhibit 218. Update Access Rights 

 

All existing rights for the selected company are shown. Access rights can have the statuses shown 
in Exhibit 219. 
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Exhibit 219. Access Rights Statuses 
Status Description 
Accepted Access rights accepted by the grantee company. 
Declined Access rights declined by the grantee company. 
Expired Access rights have lapsed due to timeframe. 
Pending Access granted by administrator’s company, but not accepted or declined currently. 
Relinquished Access right accepted by grantee, but then surrendered. 
Revoked Access rights removed by the grantor company. 

 
Actions allowed on this page include: 

Add Pool Right—Opens the Pool Access Right page (similar to Exhibit 198). Refer to Add Pool 
Right. The new pool right might include the grantee’s mark as part of the description. 

Add Equipment Right—Opens the Add Equipment Right page (similar to Exhibit 200). Refer to 
Add Equipment Right. The new equipment right might include the grantee’s mark as part of the 
description. 

Add Inspection Right—Opens the Inspection Access Right page (similar to Exhibit 203). Refer 
to Add Inspection Right. The new inspection right might include the grantee’s mark as part of the 
description. 

Add View Confidential Data Right—Opens the View Confidential Data Access Right page 
(Exhibit 220). Refer to Add Equipment Right for instructions. The new confidential equipment 
right might include the grantee’s mark as part of the description. A limited Timeframe of 
Authority can be imposed as well. 

Exhibit 220. View Confidential Data Access Right 
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View—Select the radio button beside the grantee access to be viewed and select View. A read-
only page (similar to Exhibit 195) opens. When finished viewing, select Done to return to the 
Update Access Rights page. 

Revoke—Select the radio button beside the grantee access to be revoked and select Revoke. A 
confirmation page is displayed. If unsure about revoking the rights, select Cancel. Otherwise, 
select Revoke. The Update Access Rights page is redisplayed with the access right status shown 
as revoked. 

Done—Returns User to the Inter-Company Right/Profiles Granted by My Company page 
(Exhibit 216). 

GRANT PROFILES 
When the administrator selects a grantee and selects Grant Profiles on the Inter-Company 
Right/Profiles Granted by My Company page, the Manage Security Profiles page is displayed 
(Exhibit 221). If no security profiles (groups of rights) have been established with this company 
previously, the list shown is empty (no profiles). 

Exhibit 221. Manage Security Profiles 

 

The grantor administrator can do the following tasks: 

Security Profile ID link—For Pending profiles, selecting the Security Profile ID link opens the 
Edit Security Profile page (similar to Exhibit 211). Refer to Editing a Security Profile. No “User” 
section is included when editing profiles for other companies, since the user population is 
unknown. Modification of the various rights and dates are the same. 

Add—Add a new security profile for the grantee company. The Add Security Profile page is 
displayed (similar to Exhibit 209). The Security Profile Name should include the grantor’s Mark, 
since, once accepted by the grantee, the profile is included in the profiles available for assigning 
to grantee users. Refer to Adding a New Security Profile. No “User” section is included when 
creating profiles for other companies, since the user population is unknown. Assignment of the 
various rights and dates are the same. 

Revoke—Check the box beside the profile to be revoked and select Revoke. There is NO 
warning prior to the revocation, and the status changes to revoked. 

Select Done to return to the Security Management page. 

Manage Inter-Company Access Rights Granted to My Company 
This function allows the grantee administrator to accept, decline, relinquish, and assign users to 
access rights granted by other companies.  
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Use the following procedure to work with access rights granted by other companies: 

1. On the Security Management page (Exhibit 193), select Manage Inter-Company Access 
Rights Granted to My Company. The Inter-Company Access Rights Granted to My 
Company page is displayed (Exhibit 222). 

Exhibit 222. Inter-Company Access Rights Granted to My Company 

 
The status of each access right is described in Exhibit 219. 

2. To view an access right, select the radio button beside the appropriate access and select View. 
The View <Type> Access Right page is displayed (Exhibit 223). The title of the View page 
reflects the type of access granted (Pool, Equipment, Inspection, or Confidential Data). 

Exhibit 223. View <Type> Access Right 

 

Depending on the type of access granted and its status, available actions vary. 
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Exhibit 224. Status-Based Actions for View 
 Actions Available 

Status Accept Assign 
to User 

Assign  
to Profile Decline Done Relinquish 

Accepted       
Declined       
Expired       
Pending       

Relinquished       
Revoked       

 
Accept—Accept the grantor’s Pending access right. The status changes to Accepted and new 
actions are available (see Exhibit 224). 

Decline—Declines the grantor’s Pending access right. The status changes to Declined and no 
further actions are available (see Exhibit 224). 

Assign to User—For Accepted access rights, opens the Intra-Company User List (Exhibit 225). 
See Assign to User. Only one user can be assigned at a time. If multiple users need this right, the 
administrator may choose to assign to a profile instead. 

Assign to Profile—Allows the administrator to add an Accepted access right to an existing 
security profile. Opens the Manage Security Profiles page (Exhibit 208). See Assign to Profile. 

Relinquish—Allows the administrator to surrender an Accepted access right. The status becomes 
Relinquished and new actions are available (see Exhibit 224). 

ASSIGN TO USER 
When the administrator views an accepted access right and selects Assign to User, the Intra-
Company User List is displayed (Exhibit 225).  
 

Exhibit 225. Intra-Company Users List 

 
1. Scroll and select the radio button beside the appropriate user. Scroll to the bottom of the page 

(press End) and choose Select. The View <Type> Access Right page is displayed with the 
selected user identified under the page title (Exhibit 226). 
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Exhibit 226. View <Type> Access Right User Assignment Example 

 

2. Adjust the allowable timeframe if the grantor’s Effective Date begins before the current date. 

3. To assign the right to the user, select Save. The View <Type> Access Right page is 
redisplayed with a success message. 

ASSIGN TO PROFILE 
If an accepted right is needed by several users, the administrator can choose to add the right to an 
existing company security profile. The access right would then apply to all users of the profile. 
When the administrator views an accepted access right and selects Assign to Profile, the Intra-
Company Security Profile List page is displayed (Exhibit 227). 



Umler® Account Administration | Security Management     
     

Revised January 2024 187 Umler Version 6.0 

Exhibit 227. Intra-Company Security Profile List 

 

1. Select radio button beside the security profile where the grantor right is to be added and 
choose Select. The <Type> Access Right page is displayed (Exhibit 228). The ID of the 
security profile that is being added to is identified under the page title. In Exhibit 228, the 
security profile ID is 11. 

Exhibit 228. <Type> Access Right 

 
2. Adjust the allowable timeframe if the grantor’s Effective Date begins before today. 
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3. To assign the right to the profile select Save. The <Type> Access Right page is redisplayed 
with a success message. 

4. Use the Intra-Company Manage Security Profiles function to add multiple users to the 
adjusted security profile. See Editing a Security Profile. 

Manage Inter-Company Profiles Granted to My Company 
This function allows the grantee administrator to accept, decline, relinquish, and assign users to 
security management profiles granted by other companies.  

Use the following procedure to access security profiles granted by other companies to the grantee: 

1. On the Security Management page (Exhibit 193), select Manage Inter-Company Profiles 
Granted to My Company. The Manage Security Profiles page is displayed (Exhibit 229). 

Exhibit 229. Manage Security Profiles for Inter-Company 

 

Profiles that are in Pending status can be processed. 

2. To decline the profile, check the box beside the profile and select Decline. The status 
becomes Declined. Nothing more can be done with the profile. 

3. To accept the Pending profile, check the box beside the profile and select Accept. The status 
becomes Accepted, a success message is shown, and the profile ID is a hyperlink. 

 

 

Umler also lists this inter-company security profile in the Available Profiles on the 
Add/Remove User to/from Security Profiles page (Exhibit 215). See Add/Remove 
User To/From Security Profiles for additional instructions.  
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Exhibit 230. Manage Security Profiles Updated 

 

4. To immediately add users, select the profile ID link. The Edit Security Profile page for the 
inter-company profile is displayed (Exhibit 231). 

Exhibit 231. Edit Security Profile for Inter-Company 

 

5. Check the box beside the User IDs who need to have the new inter-company profile assigned 
and select Save. For more information about Editing Security Profiles, see Editing a Security 
Profile. 

Special SSO Security Request for Non-Participating Companies 
This function can be used to request full SSO Umler Administrative rights on behalf of another 
company (hereafter called the Approver). The Approver might be a very small railroad without 
access to SSO/Umler and has contracted with an agency or other road (hereafter called the 
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Requestor) to handle its equipment-related tasking. This process serves as a Letter of 
Authorization (LOA). 

To be able to act on behalf of the Approver: 

• The Requestor must submit a valid request. 
• The Approver must approve the request. 
• The Railinc Umler Administrator must verify the request approval in Umler. 
• The Railinc Umler Administrator must establish the road mark authorizations in SSO. 
• The Railinc Umler Administrator must implement the approved request in Umler. 
• The Requestor (company Admin) must assign a Requestor contact for the Approver 

marks in FindUs.Rail. 
• The Requestor (company Admin) must assign appropriate rights to their Umler users. 

These tasks are described elsewhere in this guide (or in the SSO and Launch Pad Administrator 
Guide). Refer also to FindUs.Rail at https://findusrail.railinc.com/. Notification emails are sent 
throughout the process. 

1. On the Security Management page (Exhibit 193), select Special SSO Security Request from 
Non-Participating Companies. The Inter Company Authorization Request page is displayed 
(Exhibit 232). 

https://public.railinc.com/sites/default/files/documents/SSOAdminUserGuide.pdf
https://public.railinc.com/sites/default/files/documents/SSOAdminUserGuide.pdf
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Exhibit 232. Inter Company Authorization Request 

 
2. Complete the required fields. 

a. Request Authorization for Marks—Enter the marks being requested 
b. Name—Enter the name of the Approver. (e.g., John Doe) 
c. Company Name—Company Name of Approver (e.g., Very Small Railroad, Inc.) 
d. Email Address—Email for Approver (e.g., John.Doe@VerySmallRR.com) 
e. Phone Number— Approver’s phone number in AAA XXX-NNNN format 
f. Address 1—Mailing address of Approver (Address line 2 as needed) 
g. City—City of Approver 
h. State/Province—Use 2-character where possible 
i. ZIP Code—ZIP code for address 
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j. Country—Country of Approved (e.g., US) 
k. This authorization is requested through the following date—Use calendar picker to 

choose an end date. For no end date, use 12-31-9999. 
l. (Optional) Message to the Approver—Appropriate comments (e.g., “Let us know if you 

need other marks handled.”) 

3. Select Submit. A confirmation message is displayed (Exhibit 233) 

Exhibit 233. Inter Company Authorization Request Confirmation 

 
a. A confirming email is sent to the requestor.  

4. An email is sent to the approver. The approver email contains a link to a website (not shown) 
where the request can be viewed and then either rejected or approved.  

View Status of Special Umler SSO Requests 
Once an Intercompany Authorization Request has been submitted, the requestor can check the 
status of the requests.  

Use the following procedure to check the status: 

1. On the Security Management page (Exhibit 193), select View Status of Special Umler SSO 
Request. The Search Special Umler SSO Requests page is displayed (Exhibit 234). 

Exhibit 234. Search Special Umler SSO Requests 

 
2. Enter search criteria. 

a. Approver Status can be: 

• All (finds everything, recommended) 
• Pending 
• Approved 
• Rejected 
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b. User Mark (specific known marks for an Approver) 

3. Select Search. The Search Special Umler SSO Requests page is redisplayed (Exhibit 235). 

Exhibit 235. Search Special Umler SSO Requests Results 

 

This page is for viewing only. As needed, select the Search Criteria tab to modify the search 
criteria and do a different search. To exit the page, select another menu item. 
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Search User Access Rights 
An administrator can search for access rights by Access Right (Pool, Equipment, Inspection, and 
View Confidential Data), by Type (specific activities), by User ID, by status (active and inactive), 
and by timeframe. 

Use the following procedure to search User Access Rights: 

1. On the Security Management page (Exhibit 193), select Search User Access Rights. The 
Search Access Rights page is displayed (Exhibit 236). 

Exhibit 236. Search Access Rights 

 

Exhibit 237. Search Access Right(s) Field Descriptions 

Field Description 

User ID(s) Search for access rights assigned to specific users by entering user ID(s) in this 
field. Separate multiple IDs using the delimiters shown in Exhibit 23 (generally a 
single space).  

Access Right(s) Select one or more available access rights: Equipment, Inspection, Pool, and 
View Confidential Data. Hold Ctrl key to make multiple selections. 
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Field Description 

Type of Access Select one or more available types of access. Hold Ctrl key to make multiple 
selections. 

Status Default is to have neither Status selected. Check Active to search only currently 
effective access rights. Check Inactive to search expired rights. 

Timeframe of 
Authority 

Specify the Effective Date and the Expiration Date for the access right. The 
Effective date defaults to today’s date. The Expiration Date must be greater than 
or equal to the Effective Date. If a Status box is checked, this field is 
unavailable. 

 
Viewing Specific Users’ Rights 
To see what access rights a specific user currently has, enter the user ID in the User ID(s) field, 
check Active Status and select Search. The Search Access Rights Results page is displayed 
(Exhibit 238). To modify searches, select the Search Criteria tab, revise the criteria, and reselect 
Search. 

Exhibit 238. Search Access Rights Results For a Specific User 

 

The results list contains a Right Source column that identifies whether the access right is sourced 
from the user, or a security profile. The User Right ID/Profile ID column contains the unique 
IDs assigned by Umler for these rights or profiles as selectable links. 

To view the details of the access rights, select User Right/Profile ID link in the first column. 
Depending on whether the link represents a right or a profile, the <Type> Access Right (view-
only) or the Edit Security Profile page for the selected link is displayed (Exhibit 239). 

All access right detail pages via Search are read-only, so to remove individual access rights for 
the user, refer to Manage Intra-Company User Access Rights. 
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Exhibit 239. Edit Security Profile For a Specific ID 
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The administrator can choose to unassign the user from this profile by unchecking the User ID 
and selecting Save. To see the details of the specific access rights, the administrator can select the 
ID link(s) shown in the Access Rights tab to view a read-only version (Exhibit 240). Select 
Cancel to return to the Edit page. 

Exhibit 240. Equipment Access Right Read-Only 

 

Searching by Rights 
An administrator can search for users who have specific rights assigned to them (or even specific 
types of access). 

On the Search Access Rights page, select search criteria. In Exhibit 241, inspection access rights 
are included in the criteria for locomotive-related tasks. Check Active status and select Search. 
The results are shown in Exhibit 242. 
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Exhibit 241. Search Access Rights – Locomotive Inspection Example 

 

Exhibit 242. Search Access Right Results – Locomotive-related Inspections 

 

There is one security profile for the specified rights and 22 individual access rights that contain at 
least one of the specified rights and tasks. To view the details for the profile or rights, select the 
links in the left column. Refer to the Viewing Specific Users’ Rights for information about link 
detail pages. 
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Transfer Access Rights Between Companies 
These tasks are for Railinc Administrators only. 

When large groups of equipment are transferred from one company to another, the Umler record 
rights must also be transferred to allow further changes to the record (e.g., modify, pool 
assignment/unassignment) by the new company. 

Manage Access Rights Transferred by My Company 
 

 

Ensure the Company requesting to transfer the equipment to another road 
understands that once the equipment is accepted by the other road, the requesting 
company can no longer update those transferred Umler records or see any 
confidential data (regardless of the stencil mark)—the transfer is immediate. 

 
Use the following procedure to release equipment in Umler to another road:  

 
1. From the main menu, select Account Administration > Security Management. The 

Security Management page is displayed (Exhibit 193). 

2. Select the Manage Access Rights Transferred by My Company link. The Access Rights 
Transferred by My Company page is displayed (Exhibit 243). 

Exhibit 243. Access Rights Transferred by My Company 

 

3. Select Create New Access Right Transfer. The Transfer Access Right page is displayed 
(Exhibit 244). 
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Exhibit 244. Transfer Access Right 

 
4. Select the Target Company from the drop-down list. 

5. Select the type of access being transferred. In Exhibit 244, BNSF is transferring equipment 
ID BNSF666028 to CSXT. 

6. Select Transfer. The Confirm Transfer page is displayed (Exhibit 245). 
Exhibit 245. Confirm Transfer 

 
7. Select Transfer a second time. The Transfer Pending page is displayed (Exhibit 246). 
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Exhibit 246. Transfer Pending 

 
The equipment status remains Pending until the other mark accepts the transfer (described in 
Manage Access Rights Transferred to My Company). 

8. Select Done. 
 

Manage Access Rights Transferred to My Company 
Use the following procedure to accept or reject records or rights being transferred to the 
authorized user’s mark: 

1. From the main menu, select Account Administration > Security Management. The 
Security Management page is displayed (Exhibit 193). 

2. Select the Manage Access Rights Transferred to My Company link. The Transfer Access 
Right page is displayed (Exhibit 247). 
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Exhibit 247. Access Rights Transferred to My Company 

 

Exhibit 247 shows one pending transfer. 

3. Select the radio button for the pending transfer and select View. The Accept or Decline 
Transfer of Access Rights page is displayed (Exhibit 248). 

Exhibit 248. Accept or Decline Transfer of Access Rights 

 

a. To accept the transfer, select Accept. The Access Right Transfer page is displayed with 
the Status set to Accepted (Exhibit 249). 
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b. To decline the transfer, select Decline. The Access Right Transfer page is displayed with 
the Status set to Declined (similar to Exhibit 249). 

c. To exit without choosing, select Cancel to return to the Access Rights Transferred to My 
Company page (Exhibit 247). 

Exhibit 249. Access Right Transfer 

 

4. Select Done to return to the Access Rights Transferred to My Company page (Exhibit 247). 



Umler® Account Administration | Configure Ticklers     
  

  
    

  
  

Revised January 2024 204 Umler Version 6.0 

Configure Ticklers 
The Configure Ticklers function allows account administrators to specify which types of event 
notifications should be sent by Umler, and to which email addresses.  

Use the following procedure to configure ticklers: 

1. From the main menu, select Account Administration > Configure Ticklers. The Configure 
Ticklers page is displayed (Exhibit 250). 

Exhibit 250. Configure Ticklers 

 . . . 

 
2. Select the check box beside the appropriate types of messages. 

3. For each message type selected, enter at least one email address. Separate multiple email 
addresses by a comma. Optionally, check the box not to send “no change” ticklers.  

4. When all ticklers have been specified, select Save. A success message is displayed at the top 
of the page. 

5. To exit the page, select another Umler menu item. 
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Usage Statistics 
This function can be used by Company Administrators to monitor billable requests like web 
services and CSV downloads.  

Use the following procedure to monitor usage statistics: 

1. From the main menu, select Account Administration > Usage Statistics. The Usage 
Statistics page is displayed (Exhibit 251). 

Exhibit 251. Usage Statistics 

 

2. Select the users in the Select User field (multiple selection is allowed). 

3. Select from the Usage Method drop-down list: Web Services, CSV Downloads or Blue 
Card. 

4. Select the Starting and Ending Date/Time. Only whole months can be processed. 3-month 
limit. 

5. Select Submit. The results are displayed online (Exhibit 252). 
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Exhibit 252. Usage Statistics Search Results 
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Contact List 
When the Contact List is selected, the Railinc FindUs.Rail application opens in a new window or 
tab (Exhibit 253). 

Exhibit 253. FindUs.Rail 

 

The Umler Contact List has been incorporated into Railinc’s FindUs.Rail application. Refer to 
FindUs.Rail for the most recent Umler contact information. 

See the FindUs.Rail product page on Railinc.com for details. The appearance of the FindUs.Rail 
website is subject to change. It is beyond the scope of this document to discuss to use of 
FindUs.Rail. Once within the application, select the Help menu item for online assistance. 

https://findusrail.railinc.com/
https://findusrail.railinc.com/
https://public.railinc.com/products-services/findusrail
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Component Tracking/Registry 
The Component Tracking functions are described in the Umler Component Tracking User Guide, 
which can be accessed from References. See the Component Tracking product page for details. 

 

 

  

https://public.railinc.com/sites/default/files/documents/ComponentTracking_UG.pdf
https://public.railinc.com/products-services/component-tracking
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Semi-Annual Billing 
Umler is used for the safe and efficient placement, movement, and interchange of cars for railroad 
carriers and customers. Equipment registered in Umler is subject to registration fees. Any 
equipment involved in Interchange Service is required to be in Umler. Equipment no longer in 
use should be deleted from Umler to avoid registration fees. 

The invoice will require payment for equipment registered in Umler as of January 1 or July 
1. The equipment must be deleted before January 1 or July 1 in order for the car owner to NOT be 
charged. 

Equipment Query provides a quick and easy way to query Umler data and find all equipment 
registered under your assigned reporting marks. 
 

Umler Semi-Annual Registration Fee  
Invoices are based on all equipment registered in the Umler file under your assigned reporting 
marks effective on January 1 and July 1 each year, regardless of equipment status. 

The Umler per car maintenance fee is billed to Stenciled Mark Owners in February and August. 
For more information, refer to the Railinc Price List.  

• UMMBLRP10  Fleet of 1-81 units – flat fee  
• UMMBLRP30  Fleet more than 82 units – per unit fee 

It is the responsibility of each owner or their agent to maintain the accuracy of their Umler 
registration with respect to their fleet. 
 

AAR Technical Services User Fee 
Invoices are based on 7 equipment groups: Box, Gondola, Hopper, Tank, Flat, Intermodal Flat, 
and Vehicular Flat in Active or Inactive statuses only. 
 
The AAR Technical Services User Fee is administered by Railinc and is billed to all the Umler 
owners in January and July. Refer to the AAR Field Manual Appendix E Miscellaneous Fees for 
pricing details. 
 

• AARTCHUSR  Fleet of 1-45 units – flat fee  
• AARTCHUSR  Fleet more than 46 units – per unit fee 

 
It is the responsibility of each owner or their agent to maintain the accuracy of their Umler 
registration with respect to their fleet. 
 
 

https://public.railinc.com/support/railinc-price-list
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AAR Intermodal User Fee 
Invoices are based on 3 equipment groups: Trailers, Containers, and Chassis in Active or Inactive 
statuses only. 
 
The AAR Intermodal User Fee is administered by Railinc and is only billed to the Umler owners 
in January and July. Refer to the AAR Field Manual Appendix E Miscellaneous Fees for pricing 
details. 
 

• AARINTRMDL – price for each piece of equipment   
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Help 
Umler provides several forms of help from within the application. Select the References menu 
item for access to all Umler-related training materials on Railinc.com.  

Field help links for Umler equipment elements are available on certain pages like Display Unit 
and Modify pages. 
 

Field Help 
Field help is available for selected pages, notably the Add or Modify Equipment pages, where 
specific information available in the Umler Data Specifications Manual is needed to complete 
certain fields. 

To view helpful details about a particular element, select its ID link. Umler opens a new browser 
window with specific information related that field. 

Exhibit 254. Umler Elements Field Help  

 

The portion of the Umler Data Specifications Manual for the selected car type element is 
displayed. If the material is larger than the default window size, scroll bars are provided. To 
enlarge the print, select the magnifying glass in the lower right. When finished viewing the 
element, close the window (select the upper right X, or press Alt+F4). 

To print the help, press Ctrl+P while viewing and send to local printer. 

https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
https://public.railinc.com/sites/default/files/documents/UmlerDataSpecs.pdf
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References 
When the References menu item is selected, the Umler product page on Railinc.com opens to all 
Umler-related training materials. Scroll through this entire page for links to the most recent 
training materials (Exhibit 255), including: 

• Umler User Guide 
• Umler Data Specifications Manual  
• Umler Demos and Webinars 
• Umler Quick Guides 
• Umler Industry Reference and Load Files 
• Umler Change Request Form 
• Umler Train II Messaging Specifications Manual 

 
Exhibit 255. The Umler Product Page on Railinc.com 

 

To view a document on Railinc.com, select the link. The document opens in a new window. 

To download a PDF of a document, click the link and select the download button, which may be 
different depending on your browser (example of the download button in Chrome) and save the 
document to your computer: 

   

https://public.railinc.com/products-services/umler-system
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Add View Confidential Data Right button, 14 
description, 14 
usage, 182 

Add-Back equipment, 74 
Add-Back Multiple equipment, 76 
administrator, 21 

company, 21 
Railinc, 13 
Umler, 21 

air brake test, 109, 110 
All Saved Queries, 41 
annual inspection, 117 
application title, 11 
Assign to Profile button, 14 

description, 14 
usage, 185 

Assign to User button, 14 
description, 14 
usage, 185 

autorack inspection, 114 
Basic tab, 34 
broadcast refresh, 156 

Umler 3.1, 157 
Umler 3.2, 156 

button 
command (Umler-specific), 14 
Expand All, 14 
Umler-specific, 14 

car grade inspection, 98 
from Maintenance Inspection menu, 115 
from Maintenance menu, 98 

Car Management, 93 
create pool header, 94 
delete pool header, 97 
remove lessee, 98 
report car grade inspection, 98 
submenu, 93 
update equipment management codes, 98 
update pool assignments, 103 

Car Management Query, 42 
Equipment View, 42 
Pool View, 47 

change equipment group, 87 
check box 

appearance toggle, 13 
Differing elements only, 13 
Flat View, 13 
Show database values, 13 
Show database values (Comparison), 65 
Show database values (Display), 24 
Spanish language, 13 
Umler-specific, 13 

clone, 72 
access right, 171 
equipment, 72 
security profile, 176 

Clone button, 14 
description, 14 
usage, 173 

Clone Rights button, 14 
description, 14 
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usage, 171 
Clone Rights from Another User button, 14 

description, 14 
usage, 171 

code, 29 
equipment management, 98 
event response, 140 
mechanical designation, 29 
Rule 260, 29 

Collapse All button, 14 
description, 14 
usage, 24 

company, 16 
contact, 55 
selecting, 16 

company-specific equipment group, 120 
add equipment, 132 
create, 130 
delete, 126 
edit, 126 
Equipment View, 123 
field descriptions, 123 
group fields tab, 123 
Group View, 123 
move equipment between, 136 
remove equipment, 135 
search, 121 
submenu, 120 
task overview, 120 
view, 126 

compare equipment unit, 64 
components by location, 79 
confidential data 

grant right to view, 182 
Confirm Clone Rights button, 14 

description, 14 
usage, 172 

conflict, 18 
query to view, 33 
viewing, 18 

contact, 10 
company, 55 
find other, 21 
FindUs.Rail, 207 
Railinc, 10 
user, 55 

contact list, 207 
contact us link, 12 
content area, 12 
copyright, 12 
correct element errors, 70 
count (obtain in query), 40 
Count Equipment button, 14 

description, 14 
for access rights, 167 

create, 94 
company-specific equipment group, 130 
PDF (for displayed Record), 24 
pool header, 94 

Create PDF link, 24 
CSC, 10 
CSV, 39 

from query, 39 
inspection history, 61 
notice query results, 144 

Customer Success Center (Railinc), 10 
Customize Query Output tab, 33 
decline, 185 

granted profile, 188 
granted right, 185 

record transfer, 203 
Decline button, 14 

description, 14 
usage, 185 

Declined status, 182 
delete, 41 

access right, 170 
company-specific equipment group, 126 
equipment, 91 
pool header, 97 
query, 41 
reason, 92 
security profile, 177 
suspended work, 149 

delimiter, 30 
Differing elements only, 65 
display unit, 23 
due date update (inspection), 118 
edit, 126 

access right, 170 
company-specific equipment group, 126 
security profile, 175 
security profile for grantee, 183 

EIN, 29, 44 
change rebuilt equipment, 29, 44 
inspection history, 57 
transaction log, 53 
unique identifier, 29, 44 

element, 69 
Available, 82 
conditional, 70 
mandatory, 69 
select for modify multiple equipment, 81 
Selected, 82 

Element Selection button, 14 
description, 14 
usage, 82 

element value criteria, 54 
in Query, 33 
in View Conflict Query, 33 
inspection history, 59 
transaction logs, 54 

email, 10 
special SSO requests, 190 
tickler, 204 
to user ID, 129 
Umler access notification, 16 
Umler administrator, 21 
Umler support, 10 

equipment, 17 
add, 68 
add right, 166 
Add-Back, 74 
clone, 72 
company-specific group, 29 
comparison, 64 
delete, 91 
Equipment Validation Requests, 19 
group, 29, 68 
lookup single, 17 
maintenance party, 90 
modify multiple, 81 
modify single, 78 
Multiple Add-Back, 76 
restencil multiple, 86 
restencil single, 84 
restricted, 29 
single lookup, 18 

Equipment Group, 29 
change, 87 
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field values, 29 
Equipment ID, 28 

CSEG query, 123 
delimiter, 30 
in Manage Future Transactions, 151 
in query, 28 
in Search Notices, 138 
query formats, 30 
wildcard, 30 

Equipment Identification Number, 29, 44 
in Inspection History, 57 
in Query, 29, 44 
in Transaction Log, 53 

Equipment Initials, 158 
Equipment Maintenance Party (update), 90 
equipment management code, 98 

MD, 99 
MR, 99 
MRR, 99 
PC, 99 
SG, 99 
TC, 99 
TCC, 99 
update, 98 
UR, 99 

Equipment Type, 29 
complete code, 29 
partial code, 29 

Equipment Validation Requests, 19 
Equipment View, 42 

Car Management Query, 42 
Company-Specific Equipment Groups Search, 123 

error, 70 
correction, 70 
element, 70 
notice, 138 

event notifications, 204 
event response code, 140 
Expand All button, 14 

description, 14 
usage, 24 

expire 
access rights status, 182 

export, 39 
query results, 39 

field description, 28 
Car Management Query, 43 
Equipment Query, 28 

field help, 211 
find other contacts, 21 
FindUs.Rail, 207 
Flat View, 24 
future transaction, 50 

create pool header, 96 
delete, 151 
delete pool header, 97 
manage, 150 
pool assignment, 104 
pool unassignment, 105 
update pool header, 50 
view, 151 

Go button, 14 
description, 14 
usage, 80 

grant, 181 
access right, 181 
equipment right, 182 
inspection right, 182 
pool right, 182 
profile, 183 

view confidential data right, 182 
Grant Access Right button, 14 

description, 14 
usage, 181 

Grant Profiles button, 14 
description, 14 
usage, 183 

granted profile, 188 
accept, 188 
decline, 188 
management, 188 

granted right, 183 
accept, 185 
assign to profile, 186 
assign to user, 185 
decline, 185 
management, 183 
relinquish, 185 
revoke, 183 
view, 183 

grantee, 180 
add new, 181 
definition, 180 

grantor (definition), 180 
group ID, 123 
Group View, 123 
Held-Short Location 

Create Pool Header, 95 
help 

field, 211 
overview, 211 

historical lineage, 61, 63 
Home/Welcome page, 16 
icon 

Umler-specific, 15 
information notice, 138 
inspection, 98 

add right, 168 
air brake, 109, 110 
air brake test device, 111 
autorack, 114 
car grade, 98, 115 
date done, 109, 110, 115 
due date update, 118 
locomotive air brake, 117 
locomotive annual, 117 
locomotive cab signals, 117 
locomotive quarterly, 117 
locomotive RCL, 117 
overview, 106 
performer, 109, 110 
record, 106 
reporter, 109, 110 

inspection history, 57 
export CSV link, 60 
query, 57 
summary result, 60 

Launch Pad, 12 
legal, 12 
legal notices, 12 
lessee, 31 

definition, 31 
remove, 98 

letter of authorization, 189 
link, 11 

contact us, 12 
Create PDF, 24 
Launch Pad, 12 
navigational, 11 
sign out, 12 
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LOA, 189 
Loading Location, 43 

Car Management Query, 43 
Create Pool Header, 95 

location SPLC, 109, 110, 115 
for Air Brake Test, 109, 110, 115 

locomotive inspection, 117 
locomotive storage event, 119 
log in, 16 
log off, 17 
logo (Railinc), 11 
Lookup tab, 24 
maintenance menu, 66 
manage future transaction, 150 
Maximum Number of Results field, 33 
MD, 99 
mechanical designation, 29 

Car Management Query, 44 
Company-Specific Equipment Groups, 123 
equipment query, 29 
transaction log, 53 

Mechanical Restriction, 101 
Mechanical Restriction Reason, 101 
menu, 12 

account administration, 158 
application, 12 
maintenance, 66 
references, 12, 212 
Security Management, 160 

message area, 12 
modify, 78 

multiple equipment, 81 
single equipment, 78 

monitor usage, 205 
move equipment (company-specific equipment group), 136 
MR, 99 
MRR, 99 
My Saved Queries, 41 
navigational link, 11 
non-SSO user requests 

check status, 192 
create, 189 

notice, 137 
CSV export, 144 
CSV file column key, 144 
details, 143 
Error, 138 
group, 138 
Information, 138 
level, 138 
management overview, 137 
status, 138 
type, 138 
upload correction, 155 
Warning, 138 

Operator, 43 
Car Management query, 43 
Pool Header maintenance, 95 

page title, 12 
PC, 99 
Pending status, 182 
pool, 160 

add right, 164 
range, 160 

pool assignment, 103 
from query, 104 
removal using query, 105 
to multiple pools, 104 
to one pool, 103 
update, 103 

pool control, 99 
pool header, 47 

create, 94 
delete, 97 
fields, 95 
update, 49 
view, 48 

Pool ID, 29 
Car Management Query, 43 
Create Pool Header, 95 
Equipment Query, 29 
transaction log, 53 

Pool Maintenance Code 
Create Pool Header, 95 

Pool Type, 43 
Car Management Query, 43 
Create Pool Header, 96 

Pool View (Car Management Query), 47 
privacy rights, 12 
quarterly inspection, 117 
query, 22 

action drop-down, 38 
browser or CSV, 33, 124, 141, 151 
Car Management, 42 
count, 40 
Count, 37 
customize output, 33 
delete, 41 
display unit, 23 
equipment, 28 
export to CSV, 39 
historical lineage, 61, 63 
inspection history, 57 
menu, 22 
Notices, 151 
Notices (Management), 141 
online results, 38 
processing options, 37 
reuse, 41 
save, 41 
saved query table, 41 
Search, 37 
sort by fields, 34 

Railinc Customer Success Center, 10 
Railinc logo, 11 
RCL inspection, 117 
record transfer, 199 

accept, 202 
decline, 203 
receipt, 201 
release, 199 
view, 202 

reference documents, 212 
references, 12 
refresh, 156 

Umler 3.1, 157 
Umler 3.2, 156 

Relinquish button, 14 
description, 14 
usage, 185 

relinquish granted right, 185 
Relinquished status, 182 
remove, 98 

from pool, 105 
lessee, 98 

Reporter, 43 
Car Management Query, 43 
Create Pool Header, 95 

restencil 
multiple equipment, 86 



Umler® Index  

Revised January 2024 217 Umler Version 6.0 

single equipment, 84 
Restore button, 14 

description, 14 
usage, 144 

resume suspended work, 147 
revoke, 183 

granted rights, 183 
granted security profile, 183 

Revoke button, 14 
description, 14 
usage, 183 

Revoked status, 182 
Rule 260 code, 29 
save query, 41 

function, 41 
Saved Queries, 41 

All Saved Queries, 41 
My Saved Queries, 41 
tab, 40 

SCAC, 158 
search, 22 

access right, 194 
Search Criteria tab, 38 
Security Management, 158 

Inter-company rights, 180 
Intra-company rights, 161 
menu (page), 160 
overview, 158 

security profile, 172 
add, 173 
add all to user, 179 
add for grantee, 183 
add grant, 185 
add/remove users, 177 
clone, 176 
definition, 172 
delete, 177 
delete access rights, 176 
edit, 175 
edit grantee, 183 
from other companies, 188 
grant, 183 
manage, 172 
name, 174 
remove all from user, 179 
revoke granted, 183 

select (in this document), 9 
SG, 99 
show database values, 13 

Comparison, 65 
Display, 24 
overview, 13 

Show Equipment button, 15 
description, 15 
usage, 48 

sign out link, 12 
Sign-On Information, 11 
single equipment lookup, 18 
Single Sign On (SSO), 16 
Spanish language option, 17 
Special Umler SSO Requests 

Approver approving, 192 
Approver rejecting, 192 
checking status, 192 
LOA, 189 
Requestor search, 192 
submitting for non-user, 189 

SPLC lookup, 109, 110, 115 
Standard Carrier Alpha Code, 158 
statistics (usage), 205 

Status, 182 
Accepted, 182 
Declined, 182 
Expired, 182 
Pending, 182 
Relinquished, 182 
Revoked, 182 

storage event (locomotive), 119 
support, 10 
suspended work, 147 

delete, 149 
resume, 147 

Switch View button, 15 
description, 15 
usage, 79 

system generated, 99 
tab 

Basic, 34 
Customize Query Output, 33 
Lookup, 24 
Saved Queries, 40 
Search Criteria, 38 

TC, 99 
TCC, 99 
terminology, 9 
terms of service, 12 
ticklers, 204 

configure, 204 
email addresses, 204 
no change, 204 

timeframe of authority, 159 
title, 11 

application, 11 
page, 12 

transaction (bulk Umler upload), 154 
transaction log, 51 

search, 51 
viewing result, 55 

transfer, 199 
receipt by company, 201 
release to company, 199 

Transfer button, 15 
description, 15 
usage, 200 

transportation code, 99 
transportation condition code, 99 
type of access, 159 
Umler, 9 

3.1 refresh, 157 
3.2 refresh, 156 
administrator, 21 
application menu, 13 
display record, 23 
Home/Welcome page, 16 
icons, 15 
requesting changes, 10 
support, 10 
transaction upload, 154 

Umler User Guide, 212 
Umler™ Component Registry, 208 
Umler™ Data Specifications Manual, 10 

description, 10 
in Reference Documents, 212 

Umler™ Industry Reference and Load Files, 212 
update, 49 

pool header, 49 
upload, 153 

notice corrections, 155 
Umler transactions, 154 

UR, 99 
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usage statistics, 205 
Use Spanish for Error Messages and Properties, 13 
user, 16 

assign access rights, 162 
assign granted right, 185 
assign security profile, 177 
SSO, 16 

user contact info, 129 
user defined routing, 99 

definition, 99 
drop-down, 101 

User ID link, 129 
validation requests 

viewing, 19 
view, 48 

company-specific equipment group, 126 

components by location, 79 
conflicts, 18 
equipment validation requests, 19 
granted right, 184 
granted rights, 183 
pool header, 48 
record transfer, 202 
status of special SSO requests, 192 

view confidential data 
grant right, 182 

warning notice, 138 
web interface, 10 

page layout, 11 
Umler-specific elements, 13 

wildcard, 30 
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